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Notations Used in This Guide

Safety Symbols
The projector and its manuals use graphical symbols and labels to indicate content that tells you how to use the projector safely.
Read and carefully follow the instructions that are marked with these symbols and labels to avoid injury to persons or damage to property.

Warning
This symbol indicates information that, if ignored, could possibly result in personal injury or even death.

Caution
This symbol indicates information that, if ignored, could possibly result in personal injury or physical damage due to incorrect handling.

General Information Notations

Attention
This label indicates procedures that may result in damage or injury if sufficient care is not taken.

This label indicates additional information that may be useful to know.

[Button name] Indicates the name of the buttons on the remote control or the control panel.
Example: [Esc] button

Menu/Setting name Indicates projector menu and setting names.
Example:
Select the Image menu.
s Image > Color Mode

This label indicates links to the related pages.

s This label indicates the projector's current menu level.

g Related Links
• "Using the Manual to Search for Information" p.6
• "Getting the Latest Version of the Documents" p.7



The PDF manual allows you to search for information you are looking for by
keyword, or jump directly to specific sections using the bookmarks. You can
also print only the pages you need. This section explains how to use a PDF
manual that has been opened in Adobe Reader X on your computer.

g Related Links
• "Searching by Keyword" p.6
• "Jumping Directly from Bookmarks" p.6
• "Printing Only the Pages You Need" p.6

Searching by Keyword

Click Edit > Advanced Search. Enter the keyword (text) for information you
want to find in the search window, and then click Search. Hits are displayed as a
list. Click one of the displayed hits to jump to that page.

Jumping Directly from Bookmarks

Click a title to jump to that page. Click + or > to view the lower level titles in
that section. To return to the previous page, perform the following operation on
your keyboard.
• Windows: Hold down Alt, and then press ←.
• Mac OS: Hold down the command key, and then press ←.

Printing Only the Pages You Need

You can extract and print only the pages you need. Click Print in the File menu,
and then specify the pages you want to print in Pages in Pages to Print.
• To specify a series of pages, enter a hyphen between the start page and the

end page.
Example: 20-25

• To specify pages that are not in series, divide the pages with commas.
Example: 5, 10, 15

Using the Manual to Search for Information 6



You can get the latest version of the manuals and specifications on the Epson
Web site.
Visit epson.sn, and enter your model name.

Getting the Latest Version of the Documents 7

http://epson.sn


Introduction to Your Projector

See these sections to learn more about your projector.

g Related Links
• "Projector Parts and Functions" p.9



The following sections explain the projector parts and their functions.

g Related Links
• "Projector Parts - Front/Top" p.9
• "Projector Parts - Rear" p.10
• "Projector Parts - Base" p.10
• "Projector Parts - Interface Ports" p.11
• "Projector Parts - Control Panel" p.11
• "Projector Parts - Remote Control" p.12

Projector Parts - Front/Top

Name Function

A Air exhaust vent Exhaust vent for air used to cool the projector internally.

Caution
While projecting, do not put your face or hands
near the air exhaust vent, and do not place
objects that may become warped or damaged
by heat near the vent. Hot air from the air
exhaust vent could cause burns, warping, or
accidents to occur.

B Lens Images are projected from here.

C Lens shutter Links to the projector's power on/off function, and
automatically opens and closes the shutter.

D Remote receiver Receives signals from the remote control.

E Front adjustable foot When setup on a surface such as a desk, turn to extend
and retract to adjust the horizontal tilt.

F [Source] button Cycles through the sources.

G Power button/
indicator ( )

Turns the projector on or off.
Lit when the projector is on.

H Air intake vent (air
filter)

Takes in air to cool the projector internally.

I Air filter cover Open to access the air filter.

J Indicators Indicates the projector's status.

K Air intake vent Takes in air to cool the projector internally.

g Related Links
• "Projector Indicator Status" p.116
• "Remote Control Operation" p.28
• "Air Filter and Vent Maintenance" p.104
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Projector Parts - Rear

Name Function

A Control panel Operates the projector.

B Interface ports Connects cables for external devices.

C Power inlet Connects the power cord to the projector.

D Cable holder Pass a commercially available cable tie through here to
secure cables.

E Security slot The security slot is compatible with the Microsaver
Security System manufactured by Kensington.

F Remote receiver Receives signals from the remote control.

g Related Links
• "Installing a Security Cable" p.69
• "Projector Parts - Interface Ports" p.11

Projector Parts - Base

Name Function

A Front adjustable feet When setup on a surface such as a desk, turn to extend
and retract to adjust the horizontal tilt.

B Ceiling mount fixing
points (four points)

Attach the optional ceiling mount here when suspending
the projector from a ceiling.

To install the optional ceiling mount,
use all four fixing points and secure
it with M4 screws (maximum depth:
9 mm).

Projector Parts and Functions 10



Name Function

C Wire clamp fixing
point

When you use the optional ceiling mount, fix the
carabiner here to attach the safety wire and prevent the
projector from falling from the ceiling or wall.

D Rear foot Stabilizes the projector on a surface such as a desk.

E Air filter cover screws Screws to fix the air filter cover in place.

g Related Links
• "Installing the Safety Wire" p.18
• "Adjusting the Projector's Tilt" p.38

Projector Parts - Interface Ports

Name Function

A
port

Connects to a streaming media player to power it.
Use to connect a USB memory device to save error and
operation log files.
It is also used for batch settings and firmware update.
Hereinafter referred to as the USB-A port.

B Service port This port is used for batch settings and firmware update.

C Trigger Out port Connects with external devices such as motorized
screens.

D LAN port Connects a LAN cable to connect to a network.

Name Function

E Opt.HDMI (300mA)
port

Connects the power supply port for the optical HDMI
cable. However, connection for all the devices is not
guaranteed. Make sure to check if your device works
beforehand.

F HDMI1 port Inputs video signals from HDMI compatible video
equipment and computers.
This port is compatible with HDCP 2.3.

G HDMI2 (eARC/ARC)
port

Inputs video signals from HDMI compatible video
equipment and computers.
This port is compatible with HDCP 2.3.
This port is compatible with HDMI eARC/ARC.

H RS-232C port Connects an RS-232C cable to control the projector
from a computer. (You do not need to use this port
normally.)

g Related Links
• "Projector Connections" p.21

Projector Parts - Control Panel
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Name Function

A [Menu] button ( ) Displays and closes the projector's menu.

B [Lens] button Adjusts the focus, size, and position of the projected
image.

C Arrow buttons Selects menu items while displaying the projector's
menu or help.
Displays the previously used Geometry Correction
adjustment screen.

D [Enter] button ( ) Enters the current selection and moves to the next level
while displaying the projector's menu or help.

E [Esc] button ( ) Stops the current function.
Moves back to the previous menu level while displaying
the projector's menu.

g Related Links
• "Adjusting the Menu Settings" p.77
• "Resizing the Image with the Zoom Feature" p.44
• "Focusing the Image with the Lens Button" p.45

Projector Parts - Remote Control

Name Function

A [On] button Turns the projector on.
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Name Function

B [Standby] button Turns the projector off.

C [HDMI1]/[HDMI2]
button

Switches the image source between the HDMI1 and
HDMI2 (eARC/ARC) ports.

D [Information] button Displays the Information screen.

E [Light Output] button Displays the Light Output screen.

F Playback control
buttons

Controls playback of the connected devices that support
the HDMI CEC standard.

G [HDMI Link] button Displays the HDMI Link screen.

H [Lens] button Adjusts the focus, size, and position of the projected
image.

I [Color Mode] button Displays the Color Mode screen.

J Arrow buttons Selects menu items while displaying the projector's
menu.

K [Enter] button Enters the current selection and moves to the next level
while displaying the projector's menu.

L [Default] button Returns the selected setting to its default value.

M [Menu] button Displays and closes the projector's menu.

N [Memory] button Displays the Memory menu.

O [Frame Int] button Sets the strength for Frame Interpolation.

P [RGBCMY] button Adjusts the hue, saturation, and brightness for each
RGBCMY color.

Q [HDR] button Displays the Dynamic Range screen.

R [Pattern] Displays the Test Pattern screen.

S [Lens1]/[Lens2]
button

Loads the lens position registered as Memory1 or
Memory2 in the Lens Position setting.

Name Function

T [Esc] button Stops the current function.
Moves back to the previous menu level while displaying
the projector's menu.

U [Image Enh] button Displays the Image Enhancement screen.

V [Fine/Fast] button Displays the Image Processing screen.

W [Aspect] button Displays the Aspect screen.

X [Blank] button Temporarily stops projection. To turn the image back
on, press this button again.

Y Illumination button When you press this button, the remote control buttons
light up for approximately 10 seconds. This is useful
when operating the remote control in the dark.

Z Remote control light
emitting area

Outputs remote control signals.

g Related Links
• "Selecting an Image Source" p.46
• "Adjusting the Menu Settings" p.77
• "Color Mode" p.49
• "Image Aspect Ratio" p.47
• "Resizing the Image with the Zoom Feature" p.44
• "Focusing the Image with the Lens Button" p.45
• "Shutting Off the Image Temporarily" p.63
• "HDMI Link Features" p.61
• "Displaying a Test Pattern" p.33
• "Setting Frame Interpolation" p.51
• "Adjusting the Light Source Brightness" p.52
• "Adjusting the Image Resolution" p.53
• "Adjusting the Hue, Saturation, and Brightness" p.58
• "Saving Settings to Memory and Using Saved Settings " p.64
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Setting Up the Projector

Follow the instructions in these sections to set up your projector.

g Related Links
• "Projector Placement" p.15
• "Installing the Safety Wire" p.18
• "Projector Connections" p.21
• "Wired Network Connection" p.25
• "Installing Batteries in the Remote Control" p.27



You can place the projector on almost any flat surface to project an image.
You can also install the projector in a ceiling mount if you want to use it in
a fixed location. An optional ceiling mount is required when suspending the
projector from a ceiling.
Note the following points when selecting a projector location:
• Place the projector on a sturdy, level surface or install it using a compatible

mount.

• Leave plenty of space around and under the projector for ventilation, and do
not place it on top of or next to anything that could block the vents.

• Place the projector so it squarely faces the screen, not at an angle.

Warning
• You must install a ceiling mount when suspending the projector from a ceiling. If

you do not install the projector correctly, it could fall and cause damage or injury.
• Do not use adhesives on the ceiling mount fixing points to prevent the screws

from loosening, or use lubricants, oils, or similar substances on the projector; the
projector case may crack causing it to fall from its ceiling mount. This could cause
serious injury to anyone under the ceiling mount and could damage the projector.

• Failure to install the ceiling mount and projector may cause the projector to fall.
Secure the mount to all of the projector's ceiling mount fixing points as specified
in the projector's User's Guide. Also, secure the projector and the mount using
wires that are strong enough to hold their weight.
Be sure to use a mount specified by Epson that is compatible with this projector.

• Do not install the projector in a location subject to high levels of dust or humidity,
or in a location subject to smoke or steam. Otherwise, it could cause a fire
or electric shock to occur. The projector's case could also deteriorate and be
damaged causing the projector to fall from the mount.
Examples of environments that could cause the projector to fall due to case
deterioration
• Locations subject to excessive smoke or airborne oil particles, such as factories

or kitchens
• Locations containing volatile solvents or chemicals, such as factories or

laboratories
• Locations where the projector could be subjected to detergents or chemicals,

such as factories or kitchens
• Locations in which aroma oils are often used, such as relaxation rooms
• Near devices that produce excessive smoke, airborne oil particles, or foam at

events
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Warning
• Do not cover the projector's air intake or air exhaust vents. If the vents are

covered, the internal temperature could rise and cause a fire.
• Do not use or store the projector in locations where it will be subject to dust or

dirt. Otherwise, the quality of the projected image may decline. If the lens or air
filter gets dusty, it may result in a malfunction or fire.

• Do not install the projector on an unstable surface or in a location beyond the
weight specifications of the projector. Otherwise, it could fall or topple causing an
accident and injury.

• When installing the projector in a high position, take measures to prevent falling
by using wires to ensure safety in an emergency, such as an earthquake, and to
prevent accidents. If it is not installed correctly, it could fall causing an accident
and injury.

• Do not install in locations where salt damage could occur, or in locations subject
to corrosive gas such as sulphuric gas from hot springs. Otherwise, corrosion
could cause the projector to fall. It could also cause the projector to malfunction.

Attention
• If you are using the projector at altitudes above 1,500 m, set the High Altitude

Mode setting to On in the projector's Installation menu to ensure the projector's
internal temperature is regulated properly.

• Try not to setup the projector in locations subject to high humidity and dust, or in
locations subject to smoke from fires or tobacco smoke.

g Related Links
• "Notes on Transporting" p.16
• "Projector Setup and Installation Options" p.16
• "Projection Distance" p.17

Notes on Transporting

There are many glass parts and precision components inside the projector. To
prevent damage due to impacts when transporting, handle the projector as
follows.
• Remove any equipment connected to the projector.
• Center the lens position using the [Lens] button. If you transport the

projector when the lens is not centered, the lens shift mechanism may be
damaged.

• Make sure the lens shutter is closed.
• When transporting the projector a long distance or as checked luggage, pack

it in a firm box with cushioning around it and mark the box "Fragile."
• When shipping the projector for repairs, place it in its original packing

materials, if possible, or use equivalent materials with cushioning around the
projector. Mark the box "Fragile."

Epson shall not be liable for any damages incurred during transportation.

Projector Setup and Installation Options

You can set up or install your projector in the following ways:
Front/Rear
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Front Ceiling/Rear Ceiling

Select the correct Projection option in the projector's Installation menu
according to the installation method being used. If necessary, turn on the Inv
Direction Button setting in the projector's Operation menu.

g Related Links
• "Projection Modes" p.34

Projection Distance

The distance at which you place the projector from the screen determines the
approximate size of the image. The image size increases the farther the projector
is from the screen, but can vary depending on the zoom factor, aspect ratio, and
other settings.
See the Appendix for details about how far to place the projector from the
screen based on the size of the projected image.

g Related Links
• "Screen Size and Projection Distance" p.132
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You can install the safety wire to prevent the projector from falling from the
ceiling.

Warning
Be sure to use the safety wire provided with the Epson ceiling mount. The safety wire
is available as an optional Safety Wire Set ELPWR01.

g Related Links
• "When Using the Ceiling Mount ELPMB22" p.18
• "When Using the Ceiling Mount ELPMB30" p.19

When Using the Ceiling Mount ELPMB22

You can attach a safety wire to your projector for increased safety as shown.
Before you start, make sure you have firmly installed the ELPMB22 ceiling
mount on the projector and have the following items that are included in the
safety wire set:
• Safety wire × 1
• Carabiner × 2
• Wire clamp × 1
• Attaching screw (M4 × 10 mm) × 1

For details on installing the ELPMB22, see the Ceiling Mount ELPMB22/
ELPMB23 Instruction Manual.

a Attach a carabiner to the hole on the ceiling mount, and tighten the
carabiner lock.

b Attach the wire clamp to another carabiner, and then use the screw to fix
the wire clamp to the wire clamp fixing point on the projector.
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c Loop the safety wire through the carabiner on the ceiling mount, and
attach both ends to the carabiner on the projector.

d Tighten the carabiner lock.

g Related Links
• "Getting the Latest Version of the Documents" p.7

When Using the Ceiling Mount ELPMB30

You can attach a safety wire to your projector for increased safety as shown.
Before you start, make sure you have firmly installed the projector plate for the
ELPMB30 ceiling mount on the projector and have the following items that are
included in the safety wire set:
• Safety wire × 1
• Carabiner × 2 (Only one carabiner is used for the ELPMB30.)
• Wire clamp × 1
• Attaching screw (M4 × 10 mm) × 1

For details on installing the ELPMB30, see the ELPMB30 User's Guide.

a Attach the wire clamp to the carabiner, and then use the screw to fix the
wire clamp to the screw into the wire clamp fixing point on the projector.
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b Loop the safety wire through the hole in the ceiling mount, and then
attach both ends to the carabiner.

c Tighten the carabiner lock.

g Related Links
• "Getting the Latest Version of the Documents" p.7
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See these sections to connect the projector to a variety of projection sources.

Attention
Check the shape and orientation of the connectors on any cable you plan to connect.
Do not force a connector into a port if it does not fit. The device or your projector
could be damaged or could malfunction.

See the Quick Reference for a list of cables supplied with your projector.
Purchase optional or commercially available cables when necessary.

g Related Links
• "Connecting to an HDMI Video Source" p.21
• "Connecting to a Computer for HDMI Video" p.22
• "Connecting to a Streaming Media Player" p.22
• "Connecting to External Devices" p.22
• "Getting the Latest Version of the Documents" p.7

Connecting to an HDMI Video Source

If your video source has an HDMI port, you can connect it to the projector
using an HDMI cable.

Attention
Do not turn on the video source before connecting it to the projector. Doing so could
damage the projector.

• If the port on the device you connect has an unusual shape, use the
cable supplied with the device or an optional cable to connect to the
projector.

• The cable differs depending on the output signal from the connected
video devices.

• Some video devices are capable of outputting different types of signals.
See your video device manual to confirm what type of signals can be
output.

• When sending 40 Gbps images such as 4K 120Hz, use an HDMI cable
(ultra-high speed). If you use an incompatible cable, images may not
be displayed correctly. If images are not displayed correctly, you may be
able to display them correctly by changing the EDID Mode setting in
the projector's Signal I/O menu.
s Signal I/O > EDID > EDID (HDMI1) > EDID Mode
s Signal I/O > EDID > EDID (HDMI2) > EDID Mode

a Connect the HDMI cable to your video source's HDMI output port.

b Connect the other end to one of the projector's HDMI ports.
If you are connecting an optical HDMI cable that has a power supply
USB cable, you must also connect the cable's USB power connector to the
Opt.HDMI (300mA) port.
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Connecting to a Computer for HDMI Video

If your computer has an HDMI port, you can connect it to the projector using
an HDMI cable.

a Connect the HDMI cable to your computer's HDMI output port.

b Connect the other end to one of the projector's HDMI ports.
If you are connecting an optical HDMI cable that has a power supply
USB cable, you must also connect the cable's USB power connector to the
Opt.HDMI (300mA) port.

Connecting to a Streaming Media Player

You can connect your streaming media player to the projector's HDMI port. By
connecting the power supply USB cable, you can power the streaming media
player from the projector.

The connection method and operating environment for the streaming
media player vary depending on the model you are using. For details, see
the documentation supplied with your streaming media player; otherwise,
it may not operate properly.

a Connect your streaming media player to the projector's HDMI port.

b Connect the power supply USB cable to the projector's USB-A port.

c Connect the other end to the streaming media player.

Connecting to External Devices

Follow the instructions in these sections to connect external devices to the
projector.
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g Related Links
• "Connecting to an eARC/ARC Compatible AV System or External Speakers"

p.23
• "Connecting to a Trigger Out Port" p.23

Connecting to an eARC/ARC Compatible AV System or External
Speakers

If your AV system or speakers, such as a sound bar, has an HDMI port, you can
connect them to the projector using an HDMI cable (with Ethernet) to output
audio to these devices.

• When the AV System is connected to the projector, set HDMI Link to
On.
s Signal I/O > HDMI Link > HDMI Link

• See the Supplemental A/V Support Specification for eARC/ARC audio
supported formats.

a Connect the HDMI cable to your AV system's or speakers' HDMI output
port (eARC/ARC compatible).

b Connect the other end to the projector's HDMI2 (eARC/ARC) port.

c Make any necessary settings on the connected AV system. See your
device's documentation for more information.

g Related Links
• "Getting the Latest Version of the Documents" p.7

Connecting to a Trigger Out Port

You can connect your projector to external devices such as motorized screens
that support a trigger signal. When active, a 12V (200 mA maximum) signal is
sent to the connected device while the projector is powered on.

a Connect a 3.5 mm stereo mini-jack cable to the external device's
trigger port. See the documentation supplied with the device for more
information.
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b Connect the other end to the projector's Trigger Out port.

c Set the Trigger Out setting in the projector's Operation menu.
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You can monitor and control your projector, over a network.
To perform these operations, connect the projector to your network, and then
set up your projector and computer.

If the Web Control Password has not been set, a screen prompting you to
set a password is displayed when you save the network settings. Follow the
on-screen instructions to set the password.

g Related Links
• "Connecting to a Wired Network" p.25
• "Selecting Wired Network Settings" p.25

Connecting to a Wired Network

To connect the projector to a wired local area network (LAN), use a 100Base-TX
or 10Base-T network cable. To ensure proper data transmission, use a Category
5 shielded cable or better.

a Connect one end of the network cable to your network hub, switch, or
router.

b Connect the other end of the cable to the projector's LAN port.

Selecting Wired Network Settings

Before you can use the projector on your network, you need to select network
settings on the projector.

Make sure you already connected the projector to your wired network
using the LAN port.

a Press the [Menu] button, select the Network menu, and press [Enter].

b Select Network Settings and press [Enter].

c To identify the projector over the network, select Projector Name and
enter a name up to 16 alphanumeric characters long.
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d Select the Wired LAN menu and press [Enter].

e Assign the IP settings for your network as necessary.
• If your network assigns addresses automatically, select IP Settings to set

the DHCP setting to On.
• If you must set addresses manually, select IP Settings to set the DHCP

setting to Off, and then enter the projector's IP Address, Subnet Mask,
and Gateway Address as necessary.

f To prevent the IP address from being displayed on the network
information screen, set the IP Address Display setting to Off.

g When you finish selecting settings, go back to the Network Settings
screen, select Set, and follow the on-screen instructions to save your
settings and exit the menus.

If the Web Control Password has not been set, a screen prompting
you to set a password is displayed when you save the network
settings. Follow the on-screen instructions to set the password.

g Related Links
• "Network Menu - Network Settings Menu" p.92
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The remote control uses the two AA batteries that came with the projector.

Attention
Make sure you read the Safety Instructions before handling the batteries.

Replace the batteries as soon as they run out. The remote control uses two
AA manganese or alkaline batteries.

a Remove the battery cover as shown.

b Remove the old batteries, if necessary.

Dispose of used batteries according to local regulations.

c Insert the batteries with the + and – ends facing as shown.

Warning
Check the positions of the (+) and (–) marks inside the battery holder to
ensure the batteries are inserted the correct way. If the batteries are not used
correctly, they could explode or leak causing a fire, injury, or damage to the
product.

d Replace the battery cover and press it down until it clicks into place.

g Related Links
• "Remote Control Operation" p.28
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Remote Control Operation

The remote control lets you control the projector from almost anywhere in the
room.
Make sure that you aim the remote control at the projector's receivers within the
distance and angles listed here.

• Avoid using the remote control in conditions with bright fluorescent
lights or in direct sunlight, or the projector may not respond to
commands. If you are not going to use the remote control for a long
time, remove the batteries.
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Using Basic Projector Features

Follow the instructions in these sections to use your projector's basic features.

g Related Links
• "Turning On the Projector" p.30
• "Turning Off the Projector" p.32
• "Displaying a Test Pattern" p.33
• "Projection Modes" p.34
• "Adjusting the Image Position Using Lens Shift" p.36
• "Adjusting the Projector's Tilt" p.38
• "Image Shape" p.39
• "Resizing the Image with the Zoom Feature" p.44
• "Focusing the Image with the Lens Button" p.45
• "Selecting an Image Source" p.46
• "Image Aspect Ratio" p.47
• "Color Mode" p.49
• "Adjusting the Image Quality" p.50
• "Adjusting the Image Color" p.55



Turn on the computer or video equipment you want to use after you turn on the
projector.

a Connect the power cord to the projector's power inlet and plug it into an
electrical outlet.

The projector enters standby mode. This indicates that the projector is
receiving power, but is not yet turned on.

b Press the power button on the projector or the [On] button on the remote
control to turn on the projector.
The lens shutter opens and the status indicator flashes blue as the projector
warms up. Once the projector is warmed up, the status indicator stops
flashing and turns blue.

• When you turn on the projector for the first time, the initial
setup wizard is displayed. Make the focus, projection direction,
and language settings using the arrow and [Enter] buttons on the
control panel or remote control.

• The projector's menu screens are displayed in black by default.
All of the instructions in this guide are explained using white
screens unless otherwise mentioned. You can change the color
theme using Menu Color in the projector's Display menu.

Try the following if you do not see a projected image.
• Turn on the connected computer or video device.
• Change the screen output from the computer when using a laptop computer.
• Insert a DVD or other video media, and press play (if necessary).
• Press the [Source] button on the projector.
• Press the button for the desired video source on the remote control.

Warning
• Never look into the projector lens when the light source is on. This can damage

your eyes and is especially dangerous for children.
• When turning on the projector at a distance using the remote control, make sure

there is no one looking into the lens.
• During projection, do not block the light from the projector with a book or other

objects. If the light from the projector is blocked, the area on which the light
shines becomes hot which could cause it to melt, burn, or start a fire. Also, the
lens may get hot due to the reflected light which could cause the projector to
malfunction. Turn off the projector to stop projection.

When the Direct Power On setting is set to On in the projector's
Operation menu, the projector turns on as soon as you plug it in. Note
that the projector also turns on automatically in cases such as recovery
from a power outage.
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g Related Links
• "Projector Feature Settings - Operation Menu" p.89
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Turn off the projector after use.

• Turn off this product when it is not in use to prolong the life of the
projector. Light source life varies depending on the mode selected,
environmental conditions, and usage. Brightness decreases over time.

a Press the power button on the projector or the [Standby] button on the
remote control.
The projector displays a shutdown confirmation screen.

b Press the power button on the projector or the [Standby] button on the
remote control again. (To leave it on, press any other button.)
The light source turns off, the lens shutter closes, and the status indicator
turns off.

c To transport or store the projector, make sure all of the indicators on the
projector are off, and then unplug the power cord.
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You can display a test pattern to adjust the projected image.

Some settings may not be available while displaying a test pattern. To
adjust these settings, project an image from a connected device.

a Turn on the projector.

b Press the [Pattern] button on the remote control.

You can also display a test pattern from the projector's Installation
menu.

c Select one of the following options:
• Display Position lets you display an internal pattern without

connecting a computer or video device.

• Color Isolation: R lets you display the red component of the projected
image.

• Color Isolation: G lets you display the green component of the
projected image.

• Color Isolation: B lets you display the blue component of the projected
image.

To display Color Isolation, you need to project an image from the
connected video source.

d Adjust the image as necessary.

e To cancel pattern display, press the [Pattern] button again.
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Depending on how you positioned the projector, you may need to change the
projection mode so your images project correctly.
• Front (default setting) lets you project from a table in front of the screen.
• Front/Ceiling flips the image over top-to-bottom to project upside-down

from a ceiling.
• Rear flips the image horizontally to project from behind a translucent screen.
• Rear/Ceiling flips the image over top-to-bottom and horizontally to project

from a ceiling behind a translucent screen.

g Related Links
• "Changing the Projection Mode Using the Menus" p.34
• "Projector Setup and Installation Options" p.16

Changing the Projection Mode Using the Menus

You can change the projection mode to flip the image over top-to-bottom
and/or left-to-right using the projector menus.

a Turn on the projector and display an image.

b Press the [Menu] button on the control panel or remote control.

c Select the Installation menu and press [Enter].

d Select Projection and press [Enter].

e Select a projection mode and press [Enter].
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f Press [Menu] or [Esc] to exit the menus.
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If you cannot install the projector directly in front of the screen, you can adjust
the position of the projected image using the lens shift feature.

a Turn on the projector and display an image.

b Press the [Lens] button on the control panel or remote control.

c Press the [Lens] button repeatedly until Adjust Lens Shift appears on the
screen.

d Press the arrow buttons on the remote control or the control panel to
adjust the position of the projected image as necessary.

A Maximum horizontal range (H × 24%)

B Maximum vertical range (V × 96%)

C ½ the vertical height of the image

D ½ the horizontal width of the image

You cannot move the image to both the horizontal and vertical
maximum values.

e When you are finished, press the [Esc] button on the control panel or
remote control.
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Caution
• When transporting the projector, set the lens position to the center. If you

transport the projector when the lens is not centered, the lens shift mechanism
may be damaged.

• Do not put your finger in the moving parts of the projector's lens. Otherwise an
injury could occur.

• When adjusting the image height, position the image lower than where
you want it to be and then move it up. This will help prevent the image
from moving down after adjustment.

• The image is clearest when the lens is at the home position.
• To move the lens to the home position, press and hold the [Lens]

button on the control panel or remote control for three seconds.
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If the projected image is tilted horizontally (the left and right sides of the
projected image are at different heights) when the projector is setup on a table
or other flat surface, adjust the front feet so that both sides are level with each
other.

a Turn on the projector and display an image.

b If the image is tilted, rotate the front feet to adjust their height.

A Extend the front foot

B Retract the front foot

You can adjust the position up to approximately 3 degrees.

If the projected image is unevenly rectangular, you need to adjust the image
shape.

g Related Links
• "Image Shape" p.39
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You can project an even, rectangular image by placing the projector directly in
front of the center of the screen and keeping it level. If you place the projector at
an angle to the screen, or tilt it up or down, or off to the side, you may need to
correct the image shape.
After correction, your image is slightly smaller.
For the best quality images, we recommend adjusting the installation position of
the projector to achieve the correct image size and shape.

g Related Links
• "Correcting Image Shape with H/V Keystone" p.39
• "Correcting the Image Shape with Quick Corner" p.40
• "Correcting Image Shape with Point Correction" p.42

Correcting Image Shape with H/V Keystone

You can use the projector's H/V-Keystone setting to correct the shape of an
image that is unevenly rectangular on the sides.

You can correct images up to 30º right, left, up, or down.

• You cannot combine with other correction methods.

a Turn on the projector and display an image.

b Press the [Menu] button on the control panel or remote control.

c Select the Installation menu and press [Enter].

d Select Geometry Correction and press [Enter].
You see the Geometry Correction screen.

e Select H/V-Keystone and press [Enter]. Then select Yes and press [Enter]
if necessary.
You see the H/V-Keystone adjustment screen:
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f Use the arrow buttons on the projector or the remote control to select
between vertical and horizontal keystone correction and to adjust the
image shape as necessary.
• V-Keystone

• H-Keystone

g When you are finished, press [Esc].
After correction, your image is slightly smaller.

You can also access the previously used Geometry Correction
screen by pressing the arrow buttons on the control panel.

Correcting the Image Shape with Quick Corner

You can use the projector's Quick Corner setting to correct the shape and size of
an image that is unevenly rectangular.

a Turn on the projector and display an image.

b Press the [Menu] button on the control panel or remote control.

c Select the Installation menu and press [Enter].
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d Select Geometry Correction and press [Enter].
You see the Geometry Correction screen.

e Select Quick Corner and press [Enter]. Then select Yes and press [Enter] if
necessary.
You see the area selection screen.

f Use the arrow buttons to select the area of the image you want to adjust.
Then press [Enter].

To reset the Quick Corner corrections, hold down [Esc] for about 2
seconds while the area selection screen is displayed, and then select
Yes.

g Press the arrow buttons to adjust the image shape as necessary.
To return to the area selection screen, press [Enter].

If you see this screen, you cannot adjust the shape any further in the
direction indicated by the gray triangle.

h Repeat steps 6 and 7 as needed to adjust any remaining corners.

i When you are finished, press [Esc].

The Geometry Correction setting is now set to Quick Corner in the projector's
Installation menu.
The next time you press the arrow buttons on the control panel, the area
selection screen is displayed.
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Correcting Image Shape with Point Correction

You can use the projector's Point Correction setting to fine-tune the image
shape in portions of an image. The image is divided into a grid which allows you
to move intersection points on the grid as necessary to correct distortion.

a Turn on the projector and display an image.

b Press the [Menu] button on the control panel or remote control.

c Select the Installation menu and press [Enter].

d Select Geometry Correction and press [Enter].
You see the Geometry Correction screen.
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e Select Point Correction and press [Enter]. Then select Yes and press
[Enter] if necessary.

f Select Point Correction and press [Enter].

For fine tuning, select Quick Corner to correct the shape and size of
an image roughly, and then select Point Correction to adjust them
precisely.

g Select the point number and press [Enter].
You see the grid on the projected image.

If you want to change the grid color for visibility, press [Esc], then
select a different Pattern Color setting in the Point Correction
menu.

h Use the arrow buttons to move to the point you want to correct, then press
[Enter].

i Use the arrow buttons to correct distortion as necessary.

j To correct any remaining points, press [Esc] to return to the previous
screen, then repeat steps 8 and 9.

k When you are finished, press [Esc].

• To reset the Point Correction settings to their original positions, select
Reset on the Point Correction screen.

g Related Links
• "Correcting the Image Shape with Quick Corner" p.40

Image Shape 43



You can adjust the size of the projected image using the zoom feature.

a Turn on the projector and display an image.

b Press the [Lens] button on the control panel or remote control.

c Press the [Lens] button repeatedly until Adjust Zoom is displayed on the
screen.

d Press and hold the left or right arrow button on the control panel or
remote control to resize the image.

e When you are finished, press [Esc].
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You can adjust the sharpness of the projected image using the focus feature.

a Turn on the projector and display an image.

b Press the [Lens] button on the control panel or remote control.

c Press the [Lens] button repeatedly until Adjust Focus is displayed on the
screen.

d Press and hold the left or right arrow button on the control panel or
remote control to focus the image.

e When you are finished, press [Esc].
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When multiple image sources are connected to the projector, such as a
computer and DVD player, you can switch from one image source to the other.

a Make sure the connected image source you want to use is turned on.

b For video image sources, insert a DVD or other video media and press
play.

c Do one of the following:
• Press the [Source] button on the projector until you select the source

you want.

• Press the button for the source you want on the remote control.
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The projector can display images in different width-to-height ratios called
aspect ratios. Normally, the input signal from your video source determines
the image's aspect ratio. However, you can change the aspect ratio for certain
images to fit your screen.

g Related Links
• "Changing the Image Aspect Ratio" p.47
• "Available Image Aspect Ratios" p.47

Changing the Image Aspect Ratio

You can change the aspect ratio of the displayed image.

a Turn on the projector and switch to the image source you want to use.

b Press the [Aspect] button on the remote control.

A list of the available aspect ratios appears.

c Select the aspect ratio you want to use for your input signal and press
[Enter].

d Press [Menu] or [Esc] to exit the menus.

The available aspect ratio setting varies depending on the input signal.

Available Image Aspect Ratios

You can select the following image aspect ratios, depending on the input signal
from your image source.

• Note that using the aspect ratio function of the projector to reduce,
enlarge, or split the projected image for commercial purposes or for
public viewing may infringe upon the rights of the copyright holder of
that image based on copyright law.
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Aspect mode Description

Auto Automatically sets the aspect ratio according to the
input signal.

Full Displays images using the full size of the projection
area, but does not maintain the aspect ratio.

Zoom Displays images using the full width of the projection
area and maintains the aspect ratio of the image.

Anamorphic Wide Displays images that have a 2.40:1 aspect ratio when
using a commercially available anamorphic lens. Set the
Overscan setting in the projector's Signal I/O menu to
Off or the image will not display correctly.

Horiz. Squeeze Displays images using the full width of the projection
area when using a commercially available anamorphic
lens.
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The projector offers different color modes to provide optimum brightness,
contrast, and color for a variety of viewing environments and image types.
You can select the mode designed to match your image and environment, or
experiment with the available modes.

g Related Links
• "Changing the Color Mode" p.49
• "Available Color Modes" p.49

Changing the Color Mode

You can change the projector's Color Mode using the remote control to optimize
the image for your viewing environment.

a Turn on the projector and switch to the image source you want to use.

b Press the [Color Mode] button on the remote control to change the Color
Mode.

A list of available Color Modes appears.

c Press the arrow buttons to select a color mode setting and press [Enter].

d Press [Menu] or [Esc] to exit the menus.

You can also set the Color Mode setting in the projector's Image menu.

Available Color Modes

You can set the projector to use these color modes, depending on the input
source you are using:

Color mode Description

Dynamic This is the brightest mode. Best for prioritizing
brightness.

Vivid Best for enjoying content with bright colors.

Bright Cinema Best for enjoying content such as movies in a bright
environment.

Cinema Best for enjoying content such as movies.

Natural Best for adjusting the image color.
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You can fine-tune various aspects of the quality of your projected images.

g Related Links
• "Adjusting the Sharpness" p.50
• "Setting Frame Interpolation" p.51
• "Adjusting the Light Source Brightness" p.52
• "Turning On Automatic Luminance Adjustment" p.52
• "Adjusting the Image Resolution" p.53

Adjusting the Sharpness

You can adjust the outline of the image using the Sharpness setting.

a Turn on the projector and switch to the image source you want to use.

b Press the [Menu] button on the control panel or remote control.

c Select the Image menu and press [Enter].

d Select Sharpness and choose one of the following:
• Standard: enhances outlines for the entire image; adjusts the Thin Line

Enhancement and Thick Line Enhancement settings as well (defaults
to 5).

• Thin Line Enhancement: enhances details such as hair and clothing
patterns.

• Thick Line Enhancement: enhances backgrounds and larger elements.
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e Press the left or right arrow button to adjust the sharpness of image.

Higher values make the image sharper and lower values make the image
softer.

f Press [Menu] or [Esc] to exit the menus.

Setting Frame Interpolation

You can use the projector's Frame Interpolation feature to smooth fast-moving
video by comparing consecutive image frames and inserting an intermediate
image frame between them.

Frame Interpolation is available when:
• Image Processing is set to Fine.
s Signal I/O > Image Processing

• 4K 100/120Hz signals are not input.

a Turn on the projector and switch to the image source you want to use.

b Press the [Frame Int] button on the remote control.

c Select the level of interpolation and press [Enter].

d When you are finished, press the [Frame Int] button.

• If your resulting images contain noise, turn off the Frame Interpolation
setting.

• You can also set the Frame Interpolation setting in the projector's
Image menu.
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Adjusting the Light Source Brightness

You can adjust the brightness of your projector's light source.

a Turn on the projector and switch to the image source you want to use.

b Press the [Light Output] button on the remote control.

c Use the left and right arrow buttons to select the brightness.

d Press [Menu] or [Esc] to exit the menus.

You can also set the Light Output setting in the projector's Image menu.

Turning On Automatic Luminance Adjustment

You can turn on Dynamic Contrast to automatically optimize the image
luminance. This improves the image contrast based on the brightness of the
content you project.

a Turn on the projector and switch to the image source you want to use.

b Press the [Menu] button on the control panel or remote control.

c Select the Image menu and press [Enter].

d Select Dynamic Contrast and press [Enter].

e Choose one of the following options and press [Enter]:
• Normal for standard brightness adjustment.
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• High Speed to adjust brightness as soon as the scene changes.

f Press [Menu] or [Esc] to exit the menus.

Adjusting the Image Resolution

You can adjust the resolution of the image to reproduce a clear image with an
emphatic texture and material feel.

Noise Reduction and MPEG Noise Reduction are available when:
• Image Processing is set to Fine.
s Signal I/O > Image Processing

a Turn on the projector and switch to the image source you want to use.

b Press the [Image Enh] button on the remote control.

c Select Image Preset Mode and press [Enter].

d Select the preset option and press [Enter].

The following settings saved in the preset option are applied to the image.
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• Noise Reduction
• MPEG Noise Reduction
• Super-resolution
• Auto Contrast Enhancement

e Adjust each setting in the projector's Image menu individually as
necessary.
• To reduce flickering in images, adjust the Noise Reduction setting.
• To reduce the noise or artifacts seen in MPEG video, adjust the MPEG

Noise Reduction setting.
• To reduce blurring appeared when projecting low resolution image,

adjust the Super-resolution setting.
• To create a clearer and sharper image by automatically adjusting the

contrast, adjust the Auto Contrast Enhancement setting.

The settings value in the preset option are overwritten.

f Press [Menu] or [Esc] to exit the menus.

You can also set the Image Enhancement setting in the projector's Image
menu.

Adjusting the Image Quality 54



You can fine-tune various aspects of how colors are displayed in your projected
images.

g Related Links
• "Adjusting the Color Temperature" p.55
• "Adjusting the RGB Offset and Gain" p.56
• "Adjusting the Gamma" p.56
• "Adjusting the Hue, Saturation, and Brightness" p.58

Adjusting the Color Temperature

You can set the overall color tone by adjusting the Color Temp. setting if the
image is too bluish or reddish.

a Turn on the projector and switch to the image source you want to use.

b Press the [Menu] button on the control panel or remote control.

c Select the Image menu and press [Enter].

d Select White Balance > Color Temp. and press [Enter].

e Use the left and right arrow buttons to adjust the color tone of the image.

Higher values tint the image blue and lower values tint the image red.

The temperature range is from 3200 K to 10000 K (for Natural color
mode) or is from 0 to 13 (for other color modes).
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f Press [Menu] or [Esc] to exit the menus.

Adjusting the RGB Offset and Gain

You can adjust the brightness of dark and bright areas by adjusting the Offset
and Gain settings for individual image colors.

a Turn on the projector and switch to the image source you want to use.

b Press the [Menu] button on the control panel or remote control.

c Select the Image menu and press [Enter].

d Select White Balance > Custom and press [Enter].

e Do the following as necessary for each R (red), G (green), and B (blue):
• To adjust the brightness of dark areas, adjust the Offset setting.
• To adjust the brightness of bright areas, adjust the Gain setting.

Higher values make the image brighter and lower values make the image
darker.
• In the Offset setting, shading for the dark areas is more vividly

expressed when you select a high value. When you select a low value,
the image appears more full-bodied but shading for the dark areas is
harder to distinguish.

• In the Gain setting, the bright areas become whiter and shading is lost
when you select a high value. When you select a low value, shading for
the bright areas is more vividly expressed.

f Press [Menu] or [Esc] to exit the menus.

Adjusting the Gamma

You can correct differences in projected image colors that occur between
different image sources by adjusting the Gamma setting.
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To optimize the color tone according to the scene, and to obtain a more
vivid image, correct the image by adjusting the Scene Adaptive Gamma
setting.

a Turn on the projector and switch to the image source you want to use.

b Press the [Menu] button on the control panel or remote control.

c Select the Image menu and press [Enter].

d Select Gamma and press [Enter].

e Select and adjust the correction value.

When you select a smaller value, you can reduce the overall brightness of
the image to make the image sharper. When you select a larger value, the
dark areas of images become brighter, but the color saturation for lighter
areas may become weaker.

f If you want to make finer adjustments, select Custom and press [Enter].
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g Press the left or right arrow buttons to select the color tone you want to
adjust on the gamma adjustment graph. Then press the up or down arrow
button to adjust the value and press [Enter].

h Press [Menu] or [Esc] to exit the menus.

Adjusting the Hue, Saturation, and Brightness

You can adjust the Hue, Saturation, and Brightness settings for individual image
colors.

a Turn on the projector and switch to the image source you want to use.

b Press the [RGBCMY] button on the remote control.

c Select the color to adjust, and press [Enter].

d Do the following as necessary for each setting:
• To adjust the overall hue of the color, bluish - greenish - reddish, adjust

the Hue setting.
• To adjust the overall vividness of the color, adjust the Saturation

setting.
• To adjust the overall color brightness of the color, adjust the Brightness

setting.
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e Press [Menu] or [Esc] to exit the menus.

You can also set the RGBCMY setting in the projector's Image menu.
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Adjusting Projector Features

Follow the instructions in these sections to use your projector's adjustment features.

g Related Links
• "HDMI Link Features" p.61
• "Shutting Off the Image Temporarily" p.63
• "Saving Settings to Memory and Using Saved Settings " p.64
• "Using Advanced Image Adjustment Features" p.66
• "Projector Security Features" p.68



When an audio/video source that meets the HDMI CEC standard is connected
to the projector's HDMI port, you can use the projector's remote control to
control certain features of the linked device.
Example: Projector, audio/video system, and multi-media players connection

• As long as the connected device meets the HDMI CEC standard,
you can use the HDMI Link features even if the audio/video system
in-between does not meet the HDMI CEC standard.

• Up to 3 multi-media players that meet the HDMI CEC standard can be
connected at the same time.

g Related Links
• "Operating the Connected Devices Using the HDMI Link Features" p.61

Operating the Connected Devices Using the HDMI Link
Features

You can select the connected device that is available for HDMI Link and control
the selected device using the HDMI Link features.

• When you use the HDMI Link features, set the HDMI Link setting to
On in the projector's Signal I/O menu.
s Signal I/O > HDMI Link > HDMI Link

• You must also configure the connected device. See the documentation
supplied with the device for more information.

• Some connected devices or functions of those devices may not
operate properly even if they meet the HDMI CEC standard. See the
documentation supplied with the device for more information.

• Use a cable that supports the HDMI standard.

a Press the [HDMI Link] button on the remote control.

b Make sure HDMI Link is set to On.

c Select Device Connections and press [Enter].
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d Select the device you want to control and project the image from, and
press [Enter].

• A linked device is indicated by a blue mark.
• The device name is left blank if it cannot be acquired.

e Press [Esc] to select the HDMI Link options as necessary.
• Power On Link lets you control what happens when you turn on the

projector or linked device.

• Select PJ -> Device or Bidirectional to turn the linked device
on when the projector is turned on.

• Select Device -> PJ or Bidirectional to turn the projector on
when the linked device is turned on.

• Power Off Link lets you control whether linked devices are turned off
when the projector is turned off.

• Power Off Link only works when the connected device's CEC
power link function is enabled.

• Note that depending on the status of the connected device (for
example, if it is recording), the device may not be turned off.

f Press [HDMI Link] or [Esc] to exit the menus.

You can use the projector's remote control to control the linked device such as
playback, stop, or adjust the volume.

You can also set the HDMI Link setting in the projector's Signal I/O
menu.

g Related Links
• "Input Signal Settings - Signal I/O Menu" p.84
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You can temporarily turn off the projected image.

a Press the [Blank] button on the remote control to temporarily stop
projection.

b To turn the image back on, press the [Blank] button again.

Any video action continues to run, however, so you cannot resume
projection at the point that you stopped it.
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You can save customized settings and then select the saved settings whenever
you want to use them.

a Turn on the projector and display an image.

b Press the [Memory] button on the remote control.

The Memory menu is displayed.

c Select one of the following options:
• Image lets you save your current settings for the projected image to the

projector's memory (10 memories with different names are available).

• You can save the following settings:
• Image menu settings for each color mode
• Blanking in the Installation menu

• The saved Color Mode is displayed on the right of the
memory name.

• Lens Position lets you save your current lens settings to the projector's
memory (10 memories with different names are available).

• You can save your current focus, zoom, and lens shift settings.
• You can load the saved settings from Memory1 or Memory2

by pressing the [Lens1] or [Lens2] buttons on the remote
control.

• Reset Memory Settings lets you reset all adjustment values on the
Memory menu to their default settings.

d Select one of the following options:
• Save Memory lets you save your current settings to the projector's

memory (10 memories with different names are available).

A memory name that has already been used is indicated by a
blue mark. Saving over a previously saved memory overwrites
the settings with your current settings.

• Load Memory lets you overwrite your current settings with saved
settings.
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• Rename Memory lets you rename a saved memory.
• Erase Memory lets you erase the selected memory settings.
• Reset lets you reset the name and settings of a saved memory.

e Press [Menu] or [Esc] to exit the menus.

g Related Links
• "Image Quality Settings - Image Menu" p.81
• "Projector Installation Settings - Installation Menu" p.87
• "Image Quality Memory Settings - Memory Menu" p.95

Saving Settings to Memory and Using Saved Settings 65



Follow the instructions in these sections to use your projector's advanced image
adjustments.

g Related Links
• "Adjusting the Color Tone (Color Uniformity)" p.66

Adjusting the Color Tone (Color Uniformity)

You can use the Color Uniformity feature to manually adjust the color tone
balance in the projected image.

The color tone may not be uniform even after adjusting the color
uniformity.

a Press the [Menu] button, select the Management menu, and press [Enter].

b Select Color Uniformity and press [Enter].

c Select Color Uniformity again and press [Enter].

d Select On and press [Enter]. Then press [Esc].

e Select Adjustment Level and press [Enter].

f Select the first adjustment level you want to adjust and press [Esc].
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There are eleven adjustment levels, from white to gray to black. You
can adjust each level individually.

g Select Start Adjustments and press [Enter].

h Select the area of the image you want to adjust and press [Enter].

Adjust each area individually, then select All and adjust the entire
screen.

i Select Red, Green, or Blue and adjust the color tone, if necessary.

The adjustment screen changes each time you press [Enter].

j Press [Esc] to return to the area selection screen.

k Repeat the color adjustments to each area.

l Return to step 5 and repeat all steps to adjust other levels.

m When you are finished, press [Menu] to exit.
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You can secure your projector to deter theft or prevent unintended use by
setting up the following security features:
• Lens lock security to disable zoom, focus, and lens shift operations by locking

the [Lens] button.
• Button lock security to block operation of the projector using the buttons on

the projector.
• Security cabling to physically secure the projector in place.

g Related Links
• "Locking the Projector's Lens Settings and Buttons" p.68
• "Installing a Security Cable" p.69

Locking the Projector's Lens Settings and Buttons

You can lock the buttons on the projector to prevent anyone from using the
projector. You can also lock the zoom, focus, and lens shift settings to prevent
them from being adjusted.

a Press the [Menu] button, select the Management menu, and press [Enter].

b Select one of these lock types and press [Enter]:
• To lock the [Lens] button on the control panel and remote control to

prevent the zoom, focus, and lens shift settings from being changed,
select Lens Lock.

• To lock the projector's power button, select Child Lock.
To turn the projector on, you must press the power button for longer
than three seconds.

Child Lock does not prevent the projector from turning on when
the power cord is connected if Direct Power On is set to On in
the projector's Operation menu.
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• To lock all buttons on the projector, select Control Panel Lock > Full
Lock.

You can use the remote control to control the projector even
when the buttons on the projector are locked.

• To lock all buttons on the projector except the power button, select
Control Panel Lock > Except for Power.

c If you see a confirmation prompt, select Yes and press [Enter].
The Control Panel Lock setting is applied.

d Restart the projector to apply the Child Lock setting.

g Related Links
• "Unlocking the Projector's Buttons" p.69
• "Projector Feature Settings - Operation Menu" p.89
• "Projector Administration Settings - Management Menu" p.90

Unlocking the Projector's Buttons

If the projector's buttons have been locked, do one of the following to unlock
them.
• Set Lens Lock to Off in the projector's Management menu.
• Set Child Lock to Off in the projector's Management menu.
• Set Control Panel Lock to Off in the projector's Management menu.

You can also release Control Panel Lock by holding down the [Enter]
button on the control panel for seven seconds. A message is displayed
and the lock is released.

g Related Links
• "Projector Administration Settings - Management Menu" p.90

Installing a Security Cable

You can install the security cable on the projector to deter theft.
Use the security slot on the projector to attach a Kensington Microsaver
Security system.

For more details on the Microsaver Security System, visit the Kensington
Web site.
https://www.kensington.com/
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Monitoring and Controlling the Projector

Follow the instructions in these sections to monitor and control the projector over a network.

g Related Links
• "Controlling a Networked Projector Using a Web Browser" p.71
• "Using ESC/VP21 Commands " p.75
• "PJLink Support" p.76



Once you have connected your projector to your network, you can select
projector settings and control projection using a compatible Web browser. This
lets you access the projector remotely.

• Make sure the computer and projector are connected to the network.
• You can use the following Web browsers.

• Microsoft Edge (Windows)
• Safari (Mac, iOS)

• While using the Web browser, do not connect using a proxy server. You
cannot select all of the projector menu settings or control all projector
functions using a Web browser.

• If you set the Standby Mode setting to Communication On in the
projector's Operation menu, you can use a Web browser to select
settings and control projection even if the projector is in standby mode
(when the power is off).

a Make sure the projector is turned on.

b Make sure your computer or device is connected to the same network as
the projector.

c Start your Web browser on the computer or device.

d Go to the Epson Web Control screen by entering the projector's IP
address into the browser's address box. When entering an IPv6 address,
wrap the address with [ and ].
You see the Epson Web Control screen.

A Controls the projector remotely.

B Displays a test pattern.

C Sets detailed projector settings.

D Operates the projector's menu settings with your finger or mouse.
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e Select the option corresponding to the projector function you want to
control.

You may need to log in to access some of the options on the Epson
Web Control screen. Set the following passwords first.
• To access the Basic Control option, you need to log in using

EPSONREMOTE as the user name and your Remote Password.
(No password is set by default.)
Set Basic Control to On in the projector's Network menu, and
then set the password.
sNetwork > Network Settings > Projector Control > Basic
Control

• To access other options and save settings, you need to log in
using EPSONWEB as the user name and your Web Control
Password. (No password is set by default.)
Set the password in the projector's Network menu.
sNetwork > Network Settings > Web Control Password

g Related Links
• "Web Control Options" p.72

Web Control Options

Basic Control
Options on the Basic Control screen allow you to select the input source and
control the projector.

A Returns to the Epson Web Control screen.

B Turns the projector on or off.

C Selects the input source.

D Turns the video and audio on or off temporarily.

E Adjusts the speaker volume.

F Turns the projector off.

OSD Control Pad
Options on the OSD Control Pad screen allow you to display the projector's
setting menus and select them moving your finger or mouse on the pad.
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A Returns to the Epson Web Control screen.

B Displays the projector's setting menus.

C Use your finger or mouse to navigate the menus.

D Resets the selected setting to its default value.

E Returns to the previous menu.

F Displays help topics.

Test Pattern
The Test Pattern screen displays the available test patterns and allow you to
select to project it.

A Returns to the Epson Web Control screen.

B Displays available test patterns; select to project a test pattern.

C Turns off test pattern display.

Advanced
The Advanced screen allow you to select the projector's settings.
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A Opens the menus.

B Displays the menu name you selected.

C Specifies the projector settings. (The available settings vary depending on your
projector model.)

D Locks/unlocks the projector settings.

E Updates the projector settings.

You cannot change the following settings using Epson Web Control.
• EDID
• HDMI Link
• Language
• Display Status
• Reset Network Settings
• Firmware Update

You can select the following settings only with Epson Web Control.
• HTTP port (port number used for Web Control except for 80 [default],

843, 3620, 3621, 3625, 3629, 4352, 4649, 5357, 10000, 10001, 41794)
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You can control the projector from an external device using ESC/VP21.

g Related Links
• "ESC/VP21 Command List" p.75
• "Cable Layouts" p.75

ESC/VP21 Command List

When a command is input, the projector executes the command and returns a
":", and then accepts the next command.
If the command being processed terminates abnormally, an error message is
output and a ":" is returned.
The following commands are available.
Add a Carriage Return (CR) code (0Dh) to the end of each command and
transmit.
Contact Epson for more details.

Cable Layouts

Serial connection
• Connector shape: D-Sub 9-pin (male)
• Projector input port name: RS-232C
• Cable type: Crossover (null modem) cable
In the following illustration, the projector side is shown on the left, and the
computer side on the right:

Signal name Function

GND Signal wire ground

TD Transmit data

RD Receive data

Communications protocol
• Default baud rate setting: 9600 bps
• Data length: 8 bit
• Parity: None
• Stop-bit: 1 bit
• Flow control: None
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PJLink was established by the JBMIA (Japan Business Machine and Information
System Industries Association) as a standard protocol for controlling network-
compatible projector's as part of their efforts to standardize projector control
protocols.
The projector complies with the PJLink Class2 standard established by the
JBMIA.
The port number used for the PJLink search function is 4352 (UDP).
You need to make network settings before you can use PJLink.
It complies with all commands except for the following commands defined
by PJLink Class2, and agreement was confirmed by the PJLink standard
adaptability verification.
http://pjlink.jbmia.or.jp/english/
• Non-compatible commands

Function PJLink command

Mute settings Image muting set AVMT 11

Audio muting set AVMT 21

• Input ports and corresponding input source number

Input port name Input source number

HDMI1 32

HDMI2 33

• Manufacturer name displayed for "Manufacture name information query"
EPSON

• Model name displayed for "Product name information query"
EPSON LS9000B/LS9000W
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Adjusting the Menu Settings

Follow the instructions in these sections to access the projector menu system and change projector settings.

g Related Links
• "Using the Projector's Menus" p.78
• "Using the Displayed Keyboard" p.80
• "Image Quality Settings - Image Menu" p.81
• "Input Signal Settings - Signal I/O Menu" p.84
• "Projector Installation Settings - Installation Menu" p.87
• "Projector Display Settings - Display Menu" p.88
• "Projector Feature Settings - Operation Menu" p.89
• "Projector Administration Settings - Management Menu" p.90
• "Projector Network Settings - Network Menu" p.92
• "Image Quality Memory Settings - Memory Menu" p.95
• "Projector Initial Settings and Reset Options - Initial/All Settings Menu" p.96
• "Copying Menu Settings Between Projectors (Batch Setup)" p.97



You can use the projector's menus to adjust the settings that control how your
projector works. The projector displays the menus on the screen.

a Press the [Menu] button on the control panel or remote control.
You see the menu screen.

The projector's menu screens are displayed in black by default. All
of the instructions in this guide are explained using white screens
unless otherwise mentioned. You can change the color theme using
Menu Color in the projector's Display menu.

b Press the up or down arrow buttons to move through the menus listed on
the left. The settings for each menu are displayed on the right.

c To change settings in the displayed menu, press [Enter].

d Press the up or down arrow button to move through the settings.

e To return all the menu settings to their default values, select Initial/All
Settings.

f When you finish changing settings on a menu, press [Esc].
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g Press [Menu] or [Esc] to exit the menus.

The  arrow indicates that the menu contains sub items. When you turn
on a menu setting or select a specific value for it, the menu system displays
the sub items.
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You can use the displayed keyboard to enter numbers and characters.

a Use the arrow buttons on the control panel or remote control to highlight
the number or character you want to enter and press the [Enter] button.

Each time you select the A/a key, the characters change between
upper case and lower case. Each time you select the SYM1/2 key, the
symbols enclosed by the frame change.

b After entering the text, select OK on the keyboard to confirm your entries.
Select Cancel to cancel entering text.

g Related Links
• "Available Text Using the Displayed Keyboard" p.80

Available Text Using the Displayed Keyboard

You can enter the following text when using the displayed keyboard.

Text type Details

Numbers 0123456789

Alphabet ABCDEFGHIJKLMNOPQRSTUVWXY
Z
abcdefghijklmnopqrstuvwxyz

Symbols ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^
_ ` { | } ~
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Settings on the Image menu let you adjust the quality of your image. The
available settings depend on the currently selected color mode and input source.

Setting Options Description

Color Mode See the list of
available color
modes

Adjusts the vividness of image colors for
various image types and environments.

Brightness Various levels
available

Lightens or darkens the overall image.

Contrast Various levels
available

Adjusts the difference between light and
dark areas of the image.

Color Saturation Various levels
available

Adjusts the intensity of the image colors.

Tint Various levels
available

Adjusts the balance of green to magenta
tones in the image.

Setting Options Description

Sharpness Standard
Thin Line
Enhancement
Thick Line
Enhancement

Adjusts the sharpness or softness of image
details.
Standard: enhances outlines for the
entire image; adjusts the Thin
Line Enhancement and Thick Line
Enhancement settings as well (defaults to
5).
Thin Line Enhancement: enhances
details such as hair and clothing patterns.
Thick Line Enhancement: enhances
backgrounds and larger elements.

White Balance Color Temp. Sets the color temperature according to
the color mode you selected. Higher
values tint the image blue and lower
values tint the image red.

G-M Correction Makes fine adjustments to the color tone.
Higher values tint the image green and
lower values tint the image red.

Custom Adjusts the individual R (red), G (green),
and B (blue) components of the offset and
gain.

Grayscale Adjusts the red, green, blue, and
brightness for the selected adjustment
level.

Frame
Interpolation

Off
Low
Normal
High

Adjusts the smoothness of image
movement.
This setting is displayed only when:
• Image Processing is set to Fine.
s Signal I/O > Image Processing

Light Output Various levels
available

Sets the brightness for the light source.
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Setting Options Description

Dynamic Contrast High Speed
Normal
Off

Adjusts the projected luminance based on
the image brightness.

Deinterlacing Off
Video
Film/Auto

Sets whether or not to convert interlaced-
to-progressive signals for certain video
image types.
• Off: for fast-moving video images.
• Video: for most video images.
• Film/Auto: for movies, computer

graphics, and animation.
This setting is displayed only when:
• Image Processing is set to Fine.
s Signal I/O > Image Processing

Image
Enhancement

Image Preset Mode Sets the Image Enhancement options as a
batch using preset values.

Noise Reduction Reduces flickering in images.
This setting is displayed only when:
• Image Processing is set to Fine.
s Signal I/O > Image Processing

MPEG Noise
Reduction

Reduces the noise or artifacts seen in
MPEG video.
This setting is displayed only when:
• Image Processing is set to Fine.
s Signal I/O > Image Processing

Super-resolution Reduces blurring when projecting low
resolution images.

Auto Contrast
Enhancement

Creates a clearer and sharper image by
automatically adjusting the contrast of the
projected image.

Setting Options Description

Reset Resets all adjustment values on the Image
Enhancement setting to their default
settings.

Scene Adaptive
Gamma

Various levels
available

Adjusts the coloring according to the
scene, and obtains a more vivid image.
Select a large number to enhance
contrast.

Gamma -2 to 2
Custom

Adjusts the coloring by selecting one of
the gamma correction values, or referring
to a gamma graph.

RGBCMY Various levels
available

Adjusts the hue, saturation, and
brightness of each color R (red), G
(green), B (blue), C (cyan), M (magenta),
Y (yellow) individually.

Reset to Defaults — Resets all settings for the current color
mode.

Source — Displays settings saved for each input
source.
To change settings for an input source,
make sure the source is connected and
select that source.

Aspect See the list of
available aspect
ratios

Sets the aspect ratio (width-to-height
ratio) for the selected input source.

Reset to Defaults — Resets all settings for current input
source.

Reset Image
Settings

— Resets all adjustment values on the Image
menu to their default settings.

• The Brightness setting does not affect light source brightness. To
change the light source brightness, select the Light Output setting.
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g Related Links
• "Adjusting the Image Quality" p.50
• "Available Color Modes" p.49
• "Available Image Aspect Ratios" p.47
• "Adjusting the Image Color" p.55
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Normally the projector automatically detects and optimizes the input signal
settings. If you need to customize the settings, you can use the Signal I/O menu.
The available settings depend on the currently selected input source.

Setting Options Description

Source — Displays settings saved for each input
source.
To change settings for an input source,
make sure the source is connected and
select that source.

Setting Options Description

Signal Format Video Range Sets the video range to match the setting
of input source.
• Auto: automatically sets the video

range according to the brightness
range of the current input source.

• Limited (16-235): for the brightness
range 16 to 235.

• Full (0-255): for the brightness range 0
to 255.

Overscan Auto
Off
4%
8%

Changes the projected image ratio to
make the edges visible by a selectable
percentage or automatically.

Color Space Auto
BT.709
BT.2020

Sets the conversion system for the color
space.

Dynamic Range Dynamic Range Changes the range of dark and bright
areas in images; choose from Auto
(recommended), SDR, HDR10/HDR10+,
or HLG.

Signal Status Displays the detected input image signal.
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Setting Options Description

HDR10/HDR10+
Setting

Changes the PQ (Perceptual Quantizer)
curve of the dynamic range using the
HDR PQ method.
This setting is displayed only when:
• Dynamic Range is set to Auto and

Signal Status is HDR10.
• Dynamic Range is set to Auto and

Signal Status is HDR10+.
• Dynamic Range is set to HDR10/

HDR10+.
This projector has achieved HDR10+
certification under the following
conditions.
• Screen size: 80 inches
• Projection distance: 239 cm (wide)
• Color Mode: Natural
• HDR10/HDR10+ Setting: 3

HLG Setting Changes the HLG (Hybrid Log Gamma)
curve of the dynamic range using the
HDR HLG method.
This setting is only displayed when Signal
Status is HLG, or Dynamic Range is set
to HLG.

Setting Options Description

Image Processing Fine
Fast

Improves the response speed for images
projected at high speed.
• Fine: improves the response speed for

images by selecting Off for Frame
Interpolation.
s Image > Frame Interpolation

• Fast: disables the Frame Interpolation,
Deinterlacing, Noise Reduction, and
MPEG Noise Reduction settings.
s Image > Frame Interpolation
s Image > Deinterlacing
s Image > Image Enhancement >
Noise Reduction
s Image > Image Enhancement >
MPEG Noise Reduction

HDMI IN EQ Level HDMI1
HDMI2

Adjusts the HDMI input signal level
depending on the devices connected to
the HDMI port. If there is a lot of
interference in the image, or if a problem
such as no image being projected occurs,
change the setting.
You can select the settings for individual
input sources without changing the input
source.

Reset to Defaults — Resets all settings for current input
source.
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Setting Options Description

EDID EDID (HDMI1)
EDID (HDMI2)

Describes the display capabilities of your
projector. If images are not displayed
correctly, you may be able to display them
correctly by changing this setting.
• EDID Mode: change this setting as

necessary according to the resolution
of the image.

• HDR10+: set to Off to display images
correctly when the connected image
source does not support HDR10+.

HDMI Link Device
Connections

Lists the devices connected to the HDMI
ports.
This setting is only displayed when
HDMI Link is set to On.

HDMI Link Set to On to enable the HDMI Link
features.

Power On Link Controls what happens when you turn on
the projector or connected device.
• Off: turns off the power link.
• Bidirectional: automatically turns on

the connected device when you turn
on the projector, and vice versa.

• Device -> PJ: automatically turns on
the projector when you turn on the
connected device.

• PJ -> Device: automatically turns on
the connected device when you turn
on the projector.

Power Off Link Controls whether connected devices are
turned off when you turn off the
projector.

Reset Signal I/O
Settings

— Resets all adjustment values on the Signal
I/O menu to their default settings.

g Related Links
• "HDMI Link Features" p.61
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Settings on the Installation menu help you set up your projector in your
installation environment.

Setting Options Description

Test Pattern Display Position
Color Isolation: R
Color Isolation: G
Color Isolation: B
Exit

Displays a test pattern to assist in
focusing and zooming the image and
correcting image shape (select Exit or
press the [Pattern] button to cancel
pattern display).

Projection Front
Rear
Front/Ceiling
Rear/Ceiling

Sets the way the projector faces the screen
so the image is oriented correctly.

Setting Options Description

Geometry
Correction

H/V-Keystone Manually corrects horizontal and vertical
sides.
• V-Keystone: lets you manually correct

vertical side.
• H-Keystone: lets you manually correct

horizontal side.

Quick Corner Corrects image shape and alignment
using an on-screen display.

Point Correction Divides the projected image into a grid
and corrects the distortion by moving the
selected point of intersection from side to
side and up and down.

Blanking Top
Bottom
Left
Right

Hides an area of the projected image that
you select using the arrow buttons.

High Altitude
Mode

On
Off

Regulates the projector’s operating
temperature at altitudes above 1500 m.

Reset Installation
Settings

— Resets all adjustment values on the
Installation menu to their default
settings.

g Related Links
• "Projection Modes" p.34
• "Projector Setup and Installation Options" p.16
• "Image Shape" p.39
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Settings on the Display menu let you customize various projector display
features.

Setting Options Description

No-signal Screen Black
Blue
Logo

Sets the screen color or logo to display
when no signal is received.

Startup Screen On
Off

Set to On to display a logo when the
projector starts up.

Messages On
Off

Set to On to display messages such as
input source name, color mode name,
aspect ratio, no signal message, or high
temperature warning on your projected
image.

Menu Color Black
White

Sets the color theme of the projector
menu system.

Setting Options Description

Standby
Confirmation

On
Off

Set to On to display a confirmation
screen before turning off the projector.

Panel Alignment On
Off

Set to On to correct color misalignment
in the projected image.

Select Color Select the color to correct.

Pattern Color Select the pattern used for correction.

Start Adjustments Starts panel alignment.

Memory Manages saving and loading of the color
convergence in the projected image you
have adjusted.
• Save Memory: saves your current

Panel Alignment settings to the
projector's memory (three memories
with different names are available).

• Load Memory: overwrites your
current Panel Alignment settings with
saved settings.

• Rename Memory: renames a saved
memory.

• Erase Memory: erases the selected
memory settings.

Reset Resets all adjustment values on the
Panel Alignment setting to their default
settings.

Reset Display
Settings

— Resets all adjustment values on the
Display menu to their default settings.

g Related Links
• "Shutting Off the Image Temporarily" p.63
• "Adjusting the Color Convergence (Panel Alignment)" p.109
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Settings on the Operation menu let you customize various projector features.

Setting Options Description

Direct Power On On
Off

Set to On to turn on the projector by
plugging it in without pressing the power
button.

Sleep Mode On
Off

Set to On to automatically turns off the
projector after an interval of inactivity.

Sleep Mode Timer 1 to 30 minutes Sets the interval for Sleep Mode.

Standby Mode Communication
On
Communication
Off

Set to Communication On to allow
monitoring and controlling the projector
over a network when the projector is in
standby mode.

Indicators On
Off

Set to Off to turn off the indicator lights
on the projector except when an error or
warning occurs.

Setting Options Description

Trigger Out Off
Power
Anamorphic Wide

Outputs a DC 12V signal at 200 mA
maximum from the 3.5 mm mini-jack
Trigger Out port whenever the projector
is turned on.
If you select Anamorphic Wide, voltage
is only output from the Trigger Out
port when the Aspect setting is set to
Anamorphic Wide or Horiz.Squeeze.

Inv Direction
Button

On
Off

When suspending the projector from a
ceiling, set to On to invert the operation
direction of the control panel arrow
buttons.

Reset Operation
Settings

— Resets all adjustment values on the
Operation menu to their default settings.

g Related Links
• "Turning On the Projector" p.30
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Settings on the Management menu let you customize various projector
administrative features.

Setting Options Description

Lens Lock On
Off

Locks the focus, zoom, and lens shift
settings.

Child Lock On
Off

Locks the power button on the projector's
control panel to prevent children from
turning the projector on by accident.
This setting is only displayed when
Control Panel Lock is set to Except for
Power or Off.

Setting Options Description

Control Panel Lock Full Lock
Except for Power
Off

Controls projector button locking to
secure the projector:
• Full Lock: locks all buttons.
• Except for Power: locks all buttons

except the power button.
• Off: no buttons locked.
You can use the remote control to control
the projector even when the buttons on
the projector are locked.

Color Uniformity Color Uniformity Set to On to adjust the color tone balance
for the whole screen.

Adjustment Level Sets the adjustment level.

Start Adjustments Adjusts the red, green, and blue color
tones individually for the selected area.

Reset Resets all adjustment values on the
Color Uniformity menu to their default
settings.

Log Save
Destination

Internal Memory
USB and Internal
Memory

Sets the location in which to save error
and operation log files.

Batch Setup Range All
Limited

Select All to copy all of the projector
menu settings using the batch setup
feature. Select Limited, if you do not want
to copy the following settings:
• EDID in the Signal I/O menu
• Network menu settings

Language Various languages
available

Select the language for projector menu
and message displays.
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Setting Options Description

Information Various
information

Displays information about the projector
and input sources. The displayed items
vary depending on the current input
source.

Display Status — Displays the projector's status
information.

Reset Management
Settings

— Resets all adjustment values on the
Management menu to their default
settings, except for the following:
• Language

g Related Links
• "Locking the Projector's Lens Settings and Buttons" p.68
• "Adjusting the Color Tone (Color Uniformity)" p.66
• "Copying Menu Settings Between Projectors (Batch Setup)" p.97
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Settings on the Network menu let you view network information and set up the
projector for controlling over a network.

Setting Options Description

Wired LAN Info. Various
information

Displays wired network status and details.

Network Settings — Configures your projector network
settings. See the network menu table for
details on the Network Settings.

Setting Options Description

Reset Network
Settings

— Resets all adjustment values on the
Network menu to their default settings.

Attention
All of the passwords that have
been set for the Network menu
are also reset and you need to set
them again.

g Related Links
• "Network Menu - Network Settings Menu" p.92

Network Menu - Network Settings Menu

Settings on the Network Settings menu let you select the basic network settings.

If the Web Control Password has not been set, a screen prompting you to
set a password is displayed when you save the network settings. Follow the
on-screen instructions to set the password.

Setting Options Description

Projector Name Up to 16
alphanumeric
characters
(do not use " *
+ , / : ; < = > ? [ \ ] `
| spaces)

Enter a name to identify the projector
over the network.

Web Control
Password

Up to 32
alphanumeric
characters
(do not use * :
spaces)

Enter a password to use when accessing
the projector over the Web. (The user
name is EPSONWEB. No password is set
by default.)
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Setting Options Description

Monitor Password Up to 16
alphanumeric
characters
(do not use spaces
and any symbols
other than @)

Enter a password for performing
plain text authentication for command
communication.

Wired LAN — See the Wired LAN menu table for
details.

Projector Control — See the Projector Control menu table for
details.

g Related Links
• "Network Menu - Wired LAN Menu" p.93
• "Network Menu - Projector Control Menu" p.93

Network Menu - Wired LAN Menu

Settings on the Wired LAN menu let you select the wired LAN settings.

Setting Options Description

IP Settings DHCP
IP Address
Subnet Mask
Gateway Address

Set DHCP to On if your network assigns
addresses automatically; set to Off to
manually enter the network's IP Address,
Subnet Mask, and Gateway Address
using 0 to 255 for each address field.
Do not use these addresses: 0.0.0.0,
127.x.x.x, 192.0.2.x or 224.0.0.0 through
255.255.255.255 (where x is a number
from 0 to 255) for IP Address,
255.255.255.255 or 0.0.0.0 through
254.255.255.255 for Subnet Mask, and
0.0.0.0, 127.x.x.x or 224.0.0.0 through
255.255.255.255 for Gateway Address.

Setting Options Description

IP Address Display On
Off

Set to On to display the IP address on the
network information screen.

Network Menu - Projector Control Menu

Settings on the Projector Control menu let you select settings for controlling
the projector over a network.

Setting Options Description

Basic Control On
Off

Set to On to monitor and control the
projector using Basic Control in Epson
Web Control.

Remote Password Up to 32
alphanumeric
characters
(do not use * :
spaces)

Enter a password to access the
projector using Basic Control in Epson
Web Control. (The user name is
EPSONREMOTE. No password is set by
default.)

PJLink On
Off

Set to On to enable the PJLink
notification function.

PJLink Password Up to 32
alphanumeric
characters
(do not use spaces
and any symbols)

Enter a password for using the PJLink
protocol for projector control.

Notified IP Address Various IP
addresses

Enter the IP address to receive the
projector's operating status when the
PJLink notification function is enabled.
Enter the addresses using 0 to 255 for
each address field.
Do not use these addresses: 127.x.x.x or
224.0.0.0 through 255.255.255.255 (where
x is a number from 0 to 255).
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Setting Options Description

AMX Device
Discovery

On
Off

Set to On when you want to allow the
projector to be detected by AMX Device
Discovery.

Control4 SDDP On
Off

Set to On to allow device information
to be acquired using Control4 Simple
Device Discovery Protocol (SDDP).
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Settings on the Memory menu let you save and load projector settings in the
projector's memory.

Setting Options Description

Image Save Memory Saves the current projector settings to the
projector's memory.

Load Memory Loads saved memory settings and applies
them to the current image.

Rename Memory Changes the name of the memory
settings.

Erase Memory Deletes a saved memory.

Reset Resets all saved image memories.

Lens Position Save Memory Saves the focus, zoom, and lens shift
adjustments as a lens position entry.

Load Memory Loads saved lens adjustment values.

Setting Options Description

Rename Memory Renames a saved lens position entry.

Erase Memory Deletes the saved lens position entry.

Reset Resets all saved lens position entries.

Reset Memory
Settings

— Resets all adjustment values on the
Memory menu to their default settings.

g Related Links
• "Saving Settings to Memory and Using Saved Settings " p.64
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Settings on the Initial/All Settings menu let you reset certain projector settings
to their default values and place the projector in firmware update mode so you
can update the firmware.

Setting Options Description

Reset All — Lets you select menus for resetting the
settings to default values.

Firmware Update — Enters the firmware update mode and
ready to update firmware using the USB-
A or Service port.

Reset All options
When you select Reset All, you see the following screen.

If you do not want to reset values in particular menus, deselect the check box
next to the menu name. When you are ready to reset setting values, select
Execute.
You cannot reset the following settings:
• Language

Attention
If you perform Reset All, all of the passwords that have been set for the Network
menu are also reset and you need to set them again.

g Related Links
• "Updating the Firmware" p.111
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After selecting the projector's menu settings for one projector, you can use the
following methods to copy the settings to other projectors, as long as they are
the same model.
• by using a USB flash drive
• by connecting a computer and projector using a USB cable

• Perform batch setup before adjusting the image settings such as
keystone distortion correction. Since image adjustment values are
also copied to another projector, the adjustments you made before
performing the batch setup are overwritten and the projected screen
you adjusted may change.

• Make sure Batch Setup Range is set to Limited if you do not want to
copy the following settings:
• EDID in the Signal I/O menu
• Network menu settings
sManagement > Batch Setup Range

Caution
Epson takes no responsibility for batch setup failures and associated repair costs due
to power outages, communication errors, or other problems that may cause such
failures.

g Related Links
• "Transferring Settings From a USB Flash Drive" p.97
• "Transferring Settings From a Computer" p.98

Transferring Settings From a USB Flash Drive

You can copy menu settings from one projector to another of the same model
using a USB flash drive.

The USB flash drive must use a FAT 16/32 format and not incorporate any
security function. Delete any files on the drive before using it for batch
setup or the settings may not be saved correctly.

a Disconnect the power cord from the projector, and check that all of the
projector's indicators have turned off.

b Connect an empty USB flash drive directly to the projector's USB-A port.

c Hold down the [Esc] button on the remote control or the control panel
and connect the power cord to the projector.

d When all of the projector's indicators turn on, release the [Esc] button.
The indicators start flashing and the batch setup file is written to the USB
flash drive. When writing is finished, the projector turns off.

Caution
Do not disconnect the power cord or the USB flash drive from the projector
while the file is being written. If the power cord or USB flash drive is
disconnected, the projector may not start correctly.

e Remove the USB flash drive.

The file name for the batch setup file is PJCONFDATA.bin. If you
need to change the file name, add text after PJCONFDATA using
only alphanumeric characters. If you change the PJCONFDATA
section of the file name, the projector may not be able to recognize
the file correctly.

f Disconnect the power cord from the projector to which you want to copy
settings, and check that all of the projector's indicators have turned off.
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g Connect the USB flash drive containing the saved batch setup file to the
projector's USB-A port.

h Hold down the [Menu] button on the remote control or the control panel
and connect the power cord to the projector.

i When all of the projector's indicators turn on, release the [Menu] button.
When all of the indicators start flashing, the settings are being written.
When writing is finished, the projector turns off.

Caution
Do not disconnect the power cord or the USB flash drive from the projector
while the file is being written. If the power cord or USB flash drive is
disconnected, the projector may not start correctly.

j Remove the USB flash drive.

Transferring Settings From a Computer

You can copy menu settings from one projector to another of the same model by
connecting the computer and projector with a USB cable.

You can use this batch setup method with the following operating system
versions:
• Windows 8.1 and later
• macOS 10.13.x and later

a Disconnect the power cord from the projector, and check that all of the
projector's indicators have turned off.

b Connect a USB cable to the computer's USB port and to the projector's
Service port.

c Hold down the [Esc] button on the remote control or the control panel
and connect the power cord to the projector.

d When all of the projector's indicators turn on, release the [Esc] button.
The computer recognizes the projector as a removable disk.

e Open the removable disk icon or folder, and save the batch setup file to the
computer.

The file name for the batch setup file is PJCONFDATA.bin. If you
need to change the file name, add text after PJCONFDATA using
only alphanumeric characters. If you change the PJCONFDATA
section of the file name, the projector may not be able to recognize
the file correctly.

f Eject the USB device (Windows) or drag the removable disk icon to the
Trash (Mac).

g Disconnect the USB cable.
The projector turns off.

h Disconnect the power cord from the projector to which you want to copy
settings, and check that all of the projector's indicators have turned off.

i Connect the USB cable to the computer's USB port and to the projector's
Service port.

j Hold down the [Menu] button on the remote control or the control panel
and connect the power cord to the projector.
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k When all of the projector's indicators turn on, release the [Menu] button.
The computer recognizes the projector as a removable disk.

l Copy the batch setup file (PJCONFDATA.bin) that you saved to your
computer to the top level folder of the removable disk.

Do not copy any files or folders other than the batch setup file to the
removable disk.

m Eject the USB device (Windows) or drag the removable disk icon to the
Trash (Mac).

n Disconnect the USB cable.
When all of the indicators start flashing, the settings are being written.
When writing is finished, the projector turns off.

Caution
Do not disconnect the power cord from the projector while the file is being
written. If the power cord is disconnected, the projector may not start
correctly.

g Related Links
• "Batch Setup Error Notification" p.99

Batch Setup Error Notification

The projector's indicators notify you if an error occurs during a batch setup
operation. Check the status of the projector's indicators and follow the
instructions described in the table here.

Indicator status Problem and solutions

• Laser: Orange - flashing
fast

• Temp: Orange - flashing
fast

The batch setup file may be corrupt, or the USB flash
drive may not be connected correctly.
Disconnect the USB flash drive, unplug and then plug in
the projector's power cord, and then try again.

• Power: Blue - flashing
fast

• Status: Blue - flashing
fast

• Laser: Orange - flashing
fast

• Temp: Orange - flashing
fast

Writing the settings may have failed and an error may
have occurred in the projector's firmware.
Stop using the projector, remove the power plug from
the electrical outlet. Contact Epson for help.
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Maintaining the Projector

Follow the instructions in these sections to maintain your projector.

g Related Links
• "Projector Maintenance" p.101
• "Cleaning the Lens" p.102
• "Cleaning the Projector Case" p.103
• "Air Filter and Vent Maintenance" p.104
• "Adjusting the Color Convergence (Panel Alignment)" p.109
• "Updating the Firmware" p.111



You may need to clean the projector's lens periodically, and clean the air
filter and air vents to prevent the projector from overheating due to blocked
ventilation.
The only parts you should replace are the air filter and remote control batteries.
If any other part needs replacing, contact Epson or an authorized Epson
servicer.

Warning
Before cleaning any part of the projector, turn it off and unplug the power cord.
Never open any cover on the projector, except as specifically explained in this
manual. Dangerous electrical voltages in the projector can injure you severely.
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Clean the projector's lens periodically, or whenever you notice dust or smudges
on the surface.
• To remove dust or smudges, gently wipe the lens with clean and dry lens-

cleaning paper.
• If the lens is dusty, blow off dust using a blower, and then wipe the lens.

Warning
• Before cleaning the lens, turn off the projector and unplug the power cord.
• Do not use a lens cleaner that contains flammable gas. The high heat generated

by the projector may cause a fire.

Attention
• Do not wipe the lens right after you turn off the projector. Doing so could

damage the lens.
• Do not use any harsh materials to clean the lens and do not subject the lens to

any impacts; otherwise, it could be damaged.

Before cleaning the lens, open the lens shutter by gently moving it to
the side. After cleaning, close the shutter.
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Before cleaning the projector case, turn off the projector and unplug the power
cord.
• To remove dust or dirt, use a soft, dry, lint-free cloth.
• To remove stubborn dirt, use a soft cloth moistened with water and mild

soap. Do not spray liquid directly on the projector.

Attention
Do not use wax, alcohol, benzene, paint thinner, or other chemicals to clean the
projector case. These can damage the case. Do not use canned air, or the gases
may leave a flammable residue.
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Regular filter maintenance is important to maintain your projector. Clean
the air filter when a message appears telling you the temperature inside the
projector has reached a high level. It is recommended that you clean these
parts over a 5,000 hour period. Clean them more often than this if you use
the projector in an environment that is dustier than expected. (Assuming the
projector is used in an atmosphere in which airborne particulate matter is less
than 0.04 to 0.2 mg/m3.)

Attention
If regular maintenance is not performed, your Epson projector will notify you when
the temperature inside the projector has reached a high level. Do not wait until this
warning appears to maintain your projector filter as prolonged exposure to high
temperatures may reduce the life of your projector.

g Related Links
• "Cleaning the Air Filters and Intake Vents " p.104
• "Replacing the Air Filter" p.106

Cleaning the Air Filters and Intake Vents

You need to clean the projector's air filters in the following situations:
• The filter or vents get dusty.
• You see a message telling you to clean it.

a Turn off the projector and unplug the power cord.

b Carefully remove the dust using a vacuum cleaner or a brush.

c Loosen the screws and remove the air filter cover.
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d Open the stopper.

e Pull the air filter out of the projector.

f Tap each side of the air filter 4 to 5 times to shake off any excess dust.

Attention
Do not use excessive force when tapping the air filter, or it may crack and
become unusable.

g Vacuum the front of the air filter (the side with the tabs) to remove any
remaining dust.
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Attention
• Do not rinse the air filter in water, or use any detergent or solvent to clean

it.
• Do not use canned air. The gases may leave a flammable residue or push

dust and debris into the projector's optics or other sensitive areas.

h Place the air filter in the projector as shown.

i Close the stopper until it clicks into place.

j Close the air filter cover and tighten the screws.

Replacing the Air Filter

You need to replace the air filter in the following situations:
• After cleaning the air filter, you see a message telling you to clean or replace it.
• The air filter is torn or damaged.
You can replace the air filter while the projector is mounted to the ceiling or
placed on a table.

a Turn off the projector and unplug the power cord.

Air Filter and Vent Maintenance 106



b Loosen the screws and remove the air filter cover.

c Open the stopper.

d Pull the air filter out of the projector.

Dispose of used air filters according to local regulations.
• Filter frame: Polypropylene
• Filter: Polypropylene

e Place the new air filter in the projector as shown.
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f Close the stopper until it clicks into place.

g Close the air filter cover and tighten the screws.
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You can use the Panel Alignment feature to manually adjust the color
convergence (the alignment of the red and blue colors) in the projected image.
You can adjust the pixels horizontally and vertically in increments of 0.125
pixels within a range of ± 3 pixels.

• You can adjust only the red or blue color convergence. Green is the
standard color panel and cannot be adjusted.

• Image quality may decline after performing Panel Alignment.
• Images for pixels that extend beyond the edge of the projected screen

are not displayed.

a Press the [Menu] button, select the Display menu, and then press [Enter].

b Select Panel Alignment and press [Enter].

c Select Panel Alignment and set it to On.

d Select Select Color and choose one of the following:
• R to adjust the red color convergence.
• B to adjust the blue color convergence.

e Select Pattern Color and choose the grid color displayed when making
adjustments. The available color varies depending on the Select Color
setting.
• R/G/B to display the grid color in white.
• R/G to display the grid color in yellow.
• G/B to display the grid color in cyan.

f Select Start Adjustments and press [Enter].
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g Select one of the following options:
• Select Shift the whole panel to adjust the entire panel at the same time

and go to the next step.
• Select Adjust the four corners to adjust the corners of the panel one at a

time and go to step 10.

h Use the arrow buttons on the remote control to adjust the color alignment
selected in Select Color, and then press [Enter].

Adjustment affects the grid lines in the entire screen.

i Select one of the following options:
• Select Adjust the four corners to fine-tune your adjustments.
• Select Exit to finish adjustments.

j Use the arrow buttons on the remote control to adjust the color alignment
of the screen corner highlighted by the orange box, and then press [Enter].

k When you are finished adjusting each corner of the screen, press [Enter].

l Select one of the following options:
• If your projector needs additional panel alignment, select Select

intersection and adjust. Use the arrow buttons on the remote control to
highlight the corner of any misaligned box on the screen, press [Enter],
make any necessary adjustments, and then press [Enter] again. Repeat
this step as necessary for the other intersections.

• Select Exit to finish adjustments.

m If you want to save the color convergence in the projected image you have
adjusted, select Memory > Save Memory.

Adjusting the Color Convergence (Panel Alignment) 110



When you select the Firmware Update option in the projector's Initial/All
Settings menu, the projector enters firmware update mode and is ready to
perform a firmware update using the USB-A or Service port.

g Related Links
• "Updating Firmware Using a USB Storage Device" p.111
• "Updating Firmware Using a Computer and USB Cable" p.112

Updating Firmware Using a USB Storage Device

You can update the projector's firmware using a USB storage device.

Responsibility for updating the firmware lies with the customer. If a
firmware update fails due to problems such as a power failure or
communication problems, a fee will be charged for any necessary repairs.

a Download the projector firmware file from the Epson Web site.

b Copy the downloaded firmware file to the root folder (highest folder in the
hierarchy) of the USB storage device.

• The USB storage device must be formatted in FAT format.
• Do not copy any other files to the USB storage device.
• Do not change the firmware's file name. If the file name is

changed, the firmware update will not start.
• Check that the firmware file you copied is the correct file for your

projector model. If the firmware file is not correct, the firmware
update will not start.

c Connect the USB storage device to the projector's USB-A port.

Connect the USB storage device directly to the projector. If the USB
storage device is connected using a USB hub, the firmware update
may not be applied correctly.

d Press the [Menu] button, select the Initial/All Settings menu, and press
[Enter].

e Select Firmware Update and press [Enter].
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f Select Yes to start the firmware update.

• Do not disconnect the power cord from the projector while the
firmware is updating. If the power cord is disconnected, the
projector may not start correctly.

• Do not disconnect the USB storage device from the projector
while the firmware is updating. If the USB storage device is
disconnected, the update may not be applied correctly.

All of the projector's indicators start flashing and the firmware update
starts. When the update finishes normally, the projector enters standby
status (only the power indicator is lit blue). If Direct Power On is set to
On in the projector's Operation menu, the projector turns back on again.

When the update finishes, check the Information menu in the projector's
Management menu to make sure that the Version information has been
updated to the correct firmware version.

When all indicators flash rapidly, the firmware update may have failed.
Disconnect the power cord from the projector, and then reconnect it to
the projector. If the indicators continue to flash even after reconnecting
the power cord, remove the power plug from the electrical outlet and
contact Epson.

Updating Firmware Using a Computer and USB Cable

You can update the projector's firmware using a computer and a USB cable.

• Responsibility for updating the firmware lies with the customer. If
a firmware update fails due to problems such as a power failure or
communication problems, a fee will be charged for any necessary
repairs.

• Your computer must be running one of the following operating systems
to update the firmware.
• Windows 8.1 (32- and 64-bit)
• Windows 10 (32- and 64-bit)
• Windows 11 (64-bit)
• macOS 10.13.x (64-bit)
• macOS 10.14.x (64-bit)
• macOS 10.15.x (64-bit)

a Download the projector firmware file from the Epson Web site.

• Do not change the firmware's file name. If the file name is
changed, the firmware update will not start.

• Check that the firmware file you copied is the correct file for your
projector model. If the firmware file is not correct, the firmware
update will not start.

b Connect the USB cable to the computer's USB port and to the projector's
Service port.
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c Press the [Menu] button, select the Initial/All Settings menu, and press
[Enter].

d Select Firmware Update and press [Enter].

e Select Yes to start the firmware update.

Do not disconnect the power cord from the projector while the
firmware is updating. If the power cord is disconnected, the
projector may not start correctly.

All of the projector's indicators turn on and the projector enters firmware
update mode. The computer recognizes the projector as a removable disk.

f On the computer, copy the firmware file to the root folder (highest folder
in the hierarchy) of the removable disk.

• Do not copy any other files or folders to the removable disk.
Otherwise, the files or folders may be lost.

• The projector turns off automatically if the USB cable or the
power cord are disconnected before the firmware file can be
copied to the removable disk. If this occurs, perform the
procedure again.

g Perform the steps to safely remove a USB device from the computer and
disconnect the USB cable from the projector.
All of the projector's indicators start flashing and the firmware update
starts. When the update finishes normally, the projector enters standby
status (only the power indicator is lit blue). If Direct Power On is set to
On in the projector's Operation menu, the projector turns back on again.

When the update finishes, check the Information menu in the projector's
Management menu to make sure that the Version information has been
updated to the correct firmware version.

• When all indicators flash rapidly, the firmware update may have failed.
Disconnect the power cord from the projector, and then reconnect it to
the projector. If the indicators continue to flash even after reconnecting
the power cord, remove the power plug from the electrical outlet and
contact Epson.

• If no operations are performed for 20 minutes in update mode, the
projector turns off automatically. If this occurs, perform the procedure
again.
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Solving Problems

Check the solutions in these sections if you have any problems using the projector.

g Related Links
• "Projection Problems" p.115
• "Projector Indicator Status" p.116
• "Viewing the Status Display" p.118
• "Solving Projector Power-On or Power-Off Problems" p.121
• "Solving Image Problems" p.122
• "Solving Sound Problems" p.126
• "Solving Remote Control Operation Problems" p.127
• "Solving HDMI Link Problems" p.128
• "Solving Network Problems" p.129



If the projector is not working properly, turn it off, unplug it, and then plug it
back in and turn it on.
If this does not solve the problem, check the following:
• The indicators on the projector may indicate the problem.
• The solutions in this manual can help you solve many problems.
If none of these solutions help, contact Epson for technical support.
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The indicators on the projector indicate the projector status and let you know
when a problem occurs. Check the status and color of the indicators and then
refer to this table for a solution.

• If the indicators display a pattern not listed in the table below, turn the
projector off, unplug it, and contact Epson for help.

• When the Indicators setting is set to Off in the projector's Operation
menu, all indicators are off under normal projection conditions.

A Status indicator

B Laser indicator

C Temp (temperature) indicator

D On/Standby (power) indicator

Projector status

Indicator and status Problem and solutions

Power: Lit blue
Status: Lit blue
Laser: Off
Temp: Off

Normal operation.

Power: Lit blue
Status: Flashing blue
Laser: Off
Temp: Off

Warming up, shutting down, or cooling down.
When warming up, wait about 30 seconds for an image to
appear.
All buttons are disabled during warm-up, shutting down,
and cooling down.

Power: Off
Status: Off
Laser: Off
Temp: Off

Standby or sleep mode.
When you press the power button, projection starts.

Power: Flashing blue
Status: Off
Laser: Off
Temp: Off

Preparing for monitoring and all features are disabled.

Power: Lit blue
Status: Off
Laser: Off
Temp: Off

Monitoring.

Power: Flashing blue
Status: Indicator status
varies
Laser: Indicator status
varies
Temp: Flashing orange

Projector is too hot.
• Make sure that the vents and air filter are not clogged

with dust or obstructed by nearby objects.
• Clean or replace the air filter.
• Make sure the environmental temperature is not too

hot.

Projector Indicator Status 116



Indicator and status Problem and solutions

Power: Off
Status: Flashing blue
Laser: Off
Temp: Lit orange

Projector has overheated and turned off. Leave it turned
off to cool down for 5 minutes.
• Make sure that the vents and air filter are not clogged

with dust or obstructed by nearby objects.
• Make sure the environmental temperature is not too

hot.
• Clean or replace the air filter.
• If operating the projector at high altitude, set the

High Altitude Mode setting to On in the projector's
Installation menu.

• If the problem persists, unplug the projector and
contact Epson for help.

Power: Flashing blue
Status: Indicator status
varies
Laser: Flashing orange
Temp: Indicator status
varies

Laser warning.
Turn the projector off, unplug it, and contact Epson for
help.

Power: Off
Status: Flashing blue
Laser: Lit orange
Temp: Off

Laser has a problem.
Turn the projector off, unplug it, and contact Epson for
help.

Power: Off
Status: Flashing blue
Laser: Off
Temp: Flashing orange

A fan or sensor has a problem.
Turn the projector off, unplug it, and contact Epson for
help.

Power: Off
Status: Flashing blue
Laser: Flashing orange
Temp: Off

Internal projector error.
Turn the projector off, unplug it, and contact Epson for
help.

g Related Links
• "Projector Feature Settings - Operation Menu" p.89
• "Projector Installation Settings - Installation Menu" p.87
• "Cleaning the Air Filters and Intake Vents " p.104
• "Replacing the Air Filter" p.106
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You can monitor the projector's status and view error information from the
status display.

a Turn on the projector.

b Press the [Menu] button on the control panel or remote control.

c Select the Management menu and press [Enter].

d Select Display Status and press [Enter].

e Press the left or right arrow buttons to view different categories of
information.

g Related Links
• "Projector Status Display Messages" p.118

Projector Status Display Messages

Categories on the status display let you view information about the projector
and its operation. See the Supplemental Guide for Display Status Menu for
details.

Status messages are available only in English.

System category: Displays the system status.

Information Description

<1/3> Displays the main status.

System Status Displays the operating status of the system.

Laser Status Displays the operating status of the light source.

Last Event Displays the latest warnings or errors.

Intake Air Temp Displays the air intake temperature.

Internal Temp Lv Displays the projector's internal temperature in five levels.

<2/3> Displays the operation time and light source information.

Operation Time Displays the projector's total operation time.

Laser Op. Time Displays the total operation time of the laser light source.

<3/3> Displays the status of the current input source.

Source Displays the current source.

Signal Status Displays the identification results of signals.

Resolution Displays the resolution.

Refresh Rate Displays the refresh rate and scanning method.

ColorSamp./Depth Displays the color sampling and bit depth.

Color Space Displays the color space.
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Information Description

Dynamic Range Displays the dynamic range.

Video Range Displays the video range.

Frame Interp. Displays the status of Frame Interpolation.

Version category: Displays the serial number and firmware version.

Information Description

Serial Number Displays the serial number.

Main Displays the main version information.

Video2 Displays the embedded software version.

Sub Displays the embedded software version.

HDMI Displays the embedded software version.

Pixel Shift Displays the embedded software version.

Network Wired category: Displays the wired network status.

Information Description

Projector Name Displays the name used to identify the projector when
connected to a network.

Connection Mode Displays the connection path for a wired network.

DHCP Displays the DHCP settings.

IP Display Displays the IP address display settings.

IP Address Displays the IP address.

MAC Address Displays the MAC address.

Input Signal category: Displays the signal status of the current input source.

Information Description

<1/3> -

Information Description

Sync Detect(5V) Displays the detection results of signals.

Signal Status Displays the identification results of signals.

Resolution Displays the resolution.

Refresh Rate Displays the refresh rate and scanning method.

ColorSamp./Depth Displays the color sampling and bit depth.

Color Space Displays the color space.

Dynamic Range Displays the dynamic range.

Video Range Displays the video range.

HDCP Status/Ver Displays the HDCP status and version.

Trans. Type Displays the transmission method.

Stable Time Displays the amount of operating time since the signal
changed.

<2/3> -

Signal Mode Displays the signal mode.

AVI VIC/Chk.Sum Displays the VIC code and checksum for AVI InfoFrame.

CLK-MHz/Frame-Hz Displays the actual measurement value of the pixel clock
frequency and refresh rate.

Total-H/V Displays the total number of pixels and lines including the
number of effective pixels and blanking.

Sync Polarity Displays the sync polarity of the horizontal and vertical
sync signals.

EDID Mode Displays the EDID mode.

EDID HDR10+ Displays the EDID (HDR10+) mode.

Equalizer Level Displays the equalizer level.

<3/3> -

Audio Type Displays the audio signal type input to the source device
from the HDMI port.
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Information Description

Audio Freq/Depth Displays the audio signal frequency and bit depth input to
the source device from the HDMI port.

GCP A/V Mute Displays the A/V Mute status of GCP packets.

DDC Status Displays the source device and DDC communication status.

g Related Links
• "Getting the Latest Version of the Documents" p.7
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Check the solutions in these sections if the projector does not turn on when you
press the power button or it turns off unexpectedly.

g Related Links
• "Solving Projector Power Problems" p.121
• "Solving Projector Shutdown Problems" p.121

Solving Projector Power Problems

If the projector does not turn on when you press the power button, try the
following steps until the problem is solved.

a Make sure the power cord is securely connected to the projector and to a
working electrical outlet.

b If you are using the remote control, check the batteries of the remote
control.

c The projector's buttons may be locked for security. Unlock the buttons in
Control Panel Lock or Child Lock in the projector's Management menu,
or use the remote control to turn on the projector.

d The power cord may be defective. Disconnect the cord and contact Epson
for help.

g Related Links
• "Projector Administration Settings - Management Menu" p.90

Solving Projector Shutdown Problems

If the projector's light source turns off unexpectedly, try the following steps until
the problem is solved.

a The projectors may have entered sleep mode after a period of inactivity.
Perform any operation to wake the projector. To turn off sleep mode, set
Sleep Mode to Off in the projector's Operation menu.

b If the projector's light source turns off, the status indicator is flashing, and
the temp (temperature) indicator is lit, the projector has overheated and
turned off.

g Related Links
• "Projector Feature Settings - Operation Menu" p.89
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Check the solutions in these sections if you have any problems with projected
images.

g Related Links
• "Solving Missing Image Problems" p.122
• "Adjusting an Image that is not Rectangular" p.123
• "Adjusting a Fuzzy or Blurry Image" p.123
• "Fixing Partial Image Problems" p.123
• "Adjusting an Image that Contains Noise or Static" p.124
• "Adjusting an Image with Incorrect Brightness or Colors" p.124
• "Adjusting an Upside-down Image" p.125
• "Synchronizing Image and Sound" p.125

Solving Missing Image Problems

If no image is displayed, try the following steps until the problem is solved.

a Check the projector's status:
• Press the [Blank] button on the remote control to see if the image was

temporarily turned off.
• Check the status indicator to confirm that the projector is in normal

operating status.
• Press the projector's power button to wake it from standby or sleep

mode. Also, check if the connected computer is in sleep mode or
displaying a blank screen saver.
To turn off sleep mode, set Sleep Mode to Off in the projector's
Operation menu.

b Check the cable connection:
• Make sure all necessary cables are securely connected and the power is

on for the projector.
• Connect the video source directly to the projector.

• Replace the HDMI cable with the shorter one.
• Make sure you selected the correct Signal Format or EDID setting in

the projector's Signal I/O menu, if available for your image source.

c Check the status of your video source:
• Turn on the connected video source, and press the play button to start a

video, if necessary.
• If you are projecting from a streaming media player, make sure it is

powered by the power supply USB cable on the projector.
• Make sure the connected device meets the HDMI CEC standard. See

the documentation supplied with the device for more information.
• If you are projecting from a laptop computer, make sure it is set up to

display on an external monitor.

d Check the following items:
• Turn off the projector and the connected video source, and then turn

them back on.
• Set the CEC function for the connected device again and restart the

device.
• Make sure the computer's display resolution does not exceed the

projector's resolution and frequency limits. If necessary, select a
different display resolution for your computer. (See your computer
manual for details.)

• If the other solutions do not solve the problem, reset all of the projector
settings using Reset All Config on the Initial/All Settings menu.

g Related Links
• "Projector Feature Settings - Operation Menu" p.89
• "Projector Initial Settings and Reset Options - Initial/All Settings Menu" p.96
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Adjusting an Image that is not Rectangular

If the projected image is not evenly rectangular, try the following steps until the
problem is solved.

a Place the projector directly in front of the center of the screen, facing it
squarely, if possible.

b Adjust the image shape using the Geometry Correction settings in the
projector's Installation menu.
• Adjust the H/V-Keystone setting to correct the image shape.
s Installation > Geometry Correction > H/V-Keystone

• Adjust the Quick Corner setting to correct the image shape.
s Installation > Geometry Correction > Quick Corner

• Adjust the Point Correction setting to correct slight distortion which
occurs partially.
s Installation > Geometry Correction > Point Correction

g Related Links
• "Projector Installation Settings - Installation Menu" p.87

Adjusting a Fuzzy or Blurry Image

If the projected image is fuzzy or blurry, try the following steps until the
problem is solved.

a Adjust the image focus using the [Lens] button on the control panel or
remote control.

b Position the projector close enough to the screen.

c Clean the projector's lens.

To avoid condensation on the lens after bringing the projector
in from a cold environment, let the projector warm up to room
temperature before using it.

d Adjust the Sharpness setting in the projector's Image menu to improve
image quality.

e If you are projecting from a computer, use a lower resolution or select a
resolution that matches the projector's native resolution.

g Related Links
• "Focusing the Image with the Lens Button" p.45
• "Image Quality Settings - Image Menu" p.81

Fixing Partial Image Problems

If only a partial image is displayed, try the following steps until the problem is
solved.

a Adjust the size of the projected image using the [Lens] button on the
control panel or remote control.

b Press the [Aspect] button on the remote control to select a different image
aspect ratio.

c Make sure you selected the correct projection mode. You can select this
using the Projection setting in the projector's Installation menu.

d If you are projecting from a computer, check your computer display
settings to disable dual display and set the resolution within the projector's
limits. (See your computer manual for details.)
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g Related Links
• "Resizing the Image with the Zoom Feature" p.44
• "Projector Installation Settings - Installation Menu" p.87
• "Changing the Image Aspect Ratio" p.47

Adjusting an Image that Contains Noise or Static

If the projected image contains electronic interference (noise) or static, try the
following steps until the problem is solved.

a Check the cables connecting your video source to the projector. They
should be:
• Separated from the power cord to prevent interference
• Securely connected at both ends
• Not connected to an extension cable

b Adjust the Noise Reduction, MPEG Noise Reduction, and Deinterlacing
settings in the projector's Image menu.
s Image > Image Enhancement > Noise Reduction
s Image > Image Enhancement > MPEG Noise Reduction
s Image > Image Enhancement > Deinterlacing

c If you adjusted the image shape using the projector controls, try
decreasing the Sharpness setting in the projector's Image menu to
improve image quality.

d Make sure you selected the correct Signal Format or EDID setting in the
projector's Signal I/O menu.

e Change the HDMI IN EQ Level setting in the projector's Signal I/O
menu.

f If you connected an extension power cable, try projecting without it to see
if it caused interference in the signal.

g If you are projecting from a computer, select a computer video resolution
and refresh rate that are compatible with the projector.

h If you connected an A/V system that does not support eARC/ARC to the
HDMI2 (eARC/ARC) port, the image may be distorted.

g Related Links
• "Image Quality Settings - Image Menu" p.81
• "Input Signal Settings - Signal I/O Menu" p.84

Adjusting an Image with Incorrect Brightness or Colors

If the projected image is too dark or bright, or the colors are incorrect, try the
following steps until the problem is solved.

a Press the [Color Mode] button on the remote control to try different color
modes for the image and environment.

b Check your video source settings.

c Adjust the available settings in the projector's Image menu for the current
input source, such as Brightness, Contrast, Tint, Color Saturation, and
RGBCMY.

d Make sure you selected the correct Dynamic Range setting in the
projector's Signal I/O menu.

e Make sure you selected the correct Signal Format or EDID setting in the
projector's Signal I/O menu.

Solving Image Problems 124



f Make sure all the cables are securely connected to the projector and your
video equipment. If you connected long cables, try connecting shorter
cables.

g Position the projector close enough to the screen.

g Related Links
• "Image Quality Settings - Image Menu" p.81
• "Input Signal Settings - Signal I/O Menu" p.84

Adjusting an Upside-down Image

If the projected image is upside-down, select the correct projection mode.
s Installation > Projection

g Related Links
• "Projector Installation Settings - Installation Menu" p.87

Synchronizing Image and Sound

If the projected image and the output sound are not in sync, try the following
steps until the problem is solved.

a When Image Processing is set to Fine in the projector's Signal I/O menu,
set Frame Interpolation to Off in the projector's Image menu.

b Set Image Processing to Fast in the projector's Signal I/O menu.

c Select the sound output settings of the video devices connected to the
projector. For details, see the documentation supplied with your video
device.
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If there is no sound or the volume is too low, try the following steps until the
problem is solved.

a Check the cable connections between the projector and your video/audio
source.

b Check your video/audio source to make sure the volume is turned up and
the audio output is set for the correct source.

c If you are using an eARC/ARC-compatible A/V system, check the
following items:
• Make sure your A/V system is connected to the projector's eARC/ARC

compatible HDMI port. See the Supplemental A/V Support Specification
for eARC/ARC audio supported formats.

• Make sure the cable meets the HDMI CEC standard.
• Make sure the connected A/V system meets the HDMI CEC standard.

See the documentation supplied with the device for more information.

Solving Sound Problems 126



If the projector does not respond to remote control commands, try the following
steps until the problem is solved.

If you lose the remote control, you can order another one from Epson.

a Check that the remote control batteries are installed correctly and have
power. If necessary, replace the batteries.

b Check to see if a button on the remote control is stuck down, causing it to
enter sleep mode. Release the button to wake the remote control up.

c If the image is projected from the projector, make sure you are operating
the remote control within the reception angle and range of the projector.

d Check the indicators to confirm that the projector is in normal operating
status.

e Strong fluorescent lighting, direct sunlight, or infrared device signals may
be interfering with the projector's remote receivers. Dim the lights or
move the projector away from the sun or interfering equipment.

g Related Links
• "Remote Control Operation" p.28
• "Installing Batteries in the Remote Control" p.27
• "Projector Indicator Status" p.116
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If you cannot operate the connected devices using the HDMI Link features, try
the following steps until the problem is solved.

a Make sure the cable meets the HDMI CEC standard.

b Make sure the connected device meets the HDMI CEC standard. See the
documentation supplied with the device for more information.

c Check if the device is available in the Device Connections list.
If the device does not appear in the Device Connections list, it does not
meet the HDMI CEC standards. Connect a different device.
s Signal I/O > HDMI Link > Device Connections

d Check that all cables required for HDMI Link are securely connected.

e Make sure the connected devices are turned on and in standby status. See
the documentation supplied with the device for more information.

f If you connect a new device or change the connection, set the CEC
function for the connected device again and restart the device.

g Related Links
• "Input Signal Settings - Signal I/O Menu" p.84
• "Operating the Connected Devices Using the HDMI Link Features" p.61
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Check the solutions in these sections if you have problems using the projector
on a network.

g Related Links
• "Solutions When You Cannot Access the Projector Through the Web" p.129

Solutions When You Cannot Access the Projector
Through the Web

If you are unable to access the projector through a Web browser, make sure you
are using the correct ID and password.
• Make sure you use the following user IDs. (You cannot change the user IDs.)

• To access the Basic Control option, enter EPSONREMOTE.
• To access other options and save settings, enter EPSONWEB.

• For the password, enter the password set in the projector's Network menu.
No password is set by default.

• If your Web browser is set up to connect via a proxy server, the Epson Web
Control screen cannot be displayed. Make settings for a connection without
using a proxy server.

• If you set the Standby Mode setting to Communication On in the projector's
Operation menu, make sure the network device is turned on. After turning
on the network device, turn on the projector.

The user ID and password are case sensitive.
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Appendix

Check these sections for the technical specifications and important notices about your product.

g Related Links
• "Optional Accessories and Replacement Parts" p.131
• "Screen Size and Projection Distance" p.132
• "Supported Monitor Display Resolutions" p.134
• "Projector Specifications" p.135
• "External Dimensions" p.137
• "List of Safety Symbols and Instructions" p.138
• "Laser Safety Information" p.140
• "Glossary" p.143
• "Notices" p.144



The following optional accessories and replacement parts are available. Please
purchase these products as and when needed.
The following list of optional accessories and replacement parts is current as of:
July 2024.
Details of accessories are subject to change without notice and availability may
vary depending on the country of purchase.

g Related Links
• "Mounts" p.131
• "External Devices" p.131
• "Replacement Parts" p.131

Mounts

Ceiling mount ELPMB22
Ceiling mount (Low profile) ELPMB30

Use when installing the projector on a ceiling.
Safety Wire Set ELPWR01

Use when connecting the projector to the installation mount to prevent the
projector from falling down.

Ceiling pipe (450 mm) ELPFP13
Ceiling pipe (700 mm) ELPFP14

Use when installing the projector on a high ceiling.

Special expertise is required to suspend the projector from a ceiling.
Contact Epson for help.

External Devices

Android TV™ device ELPAP12
Use this streaming media player to watch online content.

Replacement Parts

Air filter ELPAF62
Use as a replacement for used air filters.
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Check the table here to determine how far to place the projector from the screen
based on the size of the projected image.

A Projection distance (cm)

B Distance from the center of the lens to the base of the screen (This changes
depending on the setting for vertical lens shift.) (cm)

C Center of lens

16:9 screen size A B

Minimum (Wide) to
Maximum (Tele)

Vertical Lens Shift
Bottom to Top

50" 111 × 62 148 - 313 -91 - 29

60" 133 × 75 178 - 376 -109 - 35

80" 177 × 100 239 - 503 -146 - 46

16:9 screen size A B

Minimum (Wide) to
Maximum (Tele)

Vertical Lens Shift
Bottom to Top

100" 221 × 125 300 - 630 -182 - 58

150" 332 × 187 452 - 947 -273 - 86

200" 443 × 249 604 - 1264 -364 - 115

250" 553 × 311 756 - 1582 -455 - 144

300" 664 × 374 908 - 1899 -547 - 173

4:3 screen size A B

Minimum (Wide) to
Maximum (Tele)

Vertical Lens Shift
Bottom to Top

50" 102 × 76 182 - 384 -111 - 35

60" 122 × 91 219 - 462 -134 - 42

80" 163 × 122 293 - 617 -178 - 56

100" 203 × 152 368 - 772 -223 - 71

120" 244 × 183 442 - 927 -268 - 85

150" 305 × 229 554 - 1160 -334 - 106

200" 406 × 305 740 - 1548 -446 - 141

220" 447 × 335 814 - 1704 -491 - 155

244.8" 497 × 373 906 - 1896 -546 - 173

16:10 screen size A B

Minimum (Wide) to
Maximum (Tele)

Vertical Lens Shift
Bottom to Top

50" 108 × 67 160 - 339 -98 - 31

60" 129 × 81 193 - 407 -118 - 37

80" 172 × 108 259 - 544 -158 - 50
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16:10 screen size A B

Minimum (Wide) to
Maximum (Tele)

Vertical Lens Shift
Bottom to Top

100" 215 × 135 324 - 682 -197 - 62

120" 258 × 162 390 - 819 -236 - 75

150" 323 × 202 489 - 1024 -295 - 93

200" 431 × 269 653 - 1367 -394 - 125

250" 538 × 337 817 - 1710 -492 - 156

277.2" 597 × 373 907 - 1897 -546 - 173
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See the Supplemental A/V Support Specification for detailed information on
compatible refresh rates and resolutions for each compatible video display
format.

g Related Links
• "Getting the Latest Version of the Documents" p.7
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Product name EH-LS9000B/EH-LS9000W

Dimensions 520 (W) × 169 (H) × 447 (D) mm (not including
raised section)

LCD panel size 0.74"

Display method 3LCD

Number of pixels Full HD (1,920 (W) × 1,080 (H) dots) × 3

Screen resolution 8,294,400 dots (1,920 x 1,080 x 4) *

Focus adjustment Powered

Zoom adjustment 1.0 to 2.1 (Optical Zoom)

Lens Shift Powered
Maximum vertical direction: Approx. ±96.3%
Maximum horizontal direction: Approx. ±24.0%

Light source Laser diode

Light source output power Up to 88 W

Wavelength 449 to 461 nm

Laser class (internal laser
light source)

Class 4

Light source operation time
**

Up to about 20,000 hours

Speaker N/A

Power supply 100-240V AC±10% 50/60Hz 3.2 - 1.5 A

Operating power
consumption (100 to 120 V
area)

When the light source brightness is 100%: 311W
When the light source brightness is 60%: 204 W

Operating power
consumption (220 to 240 V
area)

When the light source brightness is 100%: 302W
When the light source brightness is 60%: 198W

Standby power consumption Communication On: 2.0 W
Communication Off: 0.4 W

Operating altitude Altitude 0 to 3,048 m

Operating temperature Altitude of 0 to 2,286 m: +5 to +35°C (Humidity of 20
to 80%, No condensation)
Altitude of 2,287 to 3,048 m: +5 to +30°C (Humidity
of 20 to 80%, No condensation)

Storage temperature -10 to +60°C (Humidity of 10 to 90%, No
condensation)

Mass Approx. 12.7 kg

* Pixel shifting technology achieves 4K resolution on screen.
** Approximate time until the light source brightness decreases to half of
its original value. (Assuming the projector is being used in an environment
containing airborne particles of 0.04 to 0.2 mg/m3. This is an approximate guide
only and may change depending on the projector’s usage and surroundings.)
This product is also designed for IT power distribution system with phase-to-
phase voltage 230V.
The rating label is attached on the bottom of the projector.

Angle of tilt
If you use the projector tilted at an angle greater than the one shown in the
following illustration, it could be damaged and cause an accident.

g Related Links
• "Connector Specifications" p.136
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Connector Specifications

USB-A port 1 USB connector (Type A)

Service port 1 USB connector (Mini-B)

Trigger Out port 1 Stereo mini pin jack

LAN port 1 RJ-45

Opt.HDMI (300mA) port 1 Power supply connector for optical
HDMI cable

HDMI1 port 1 HDMI

HDMI2 (eARC/ARC) port 1 HDMI

RS-232C port 1 Mini D-Sub 9-pin (male)

USB-A and Service port supports USB 2.0. However, USB ports are not
guaranteed to operate all devices that support USB.
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A Center of lens (when the lens is positioned in the center)

B Distance from center of lens to suspension bracket fixing point

The unit in these illustrations is mm.
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The following table lists the meaning of the safety symbols labeled on the
equipment.

No. Symbol mark Approved
standards

Description

A IEC60417
No. 5007

"ON" (power)
To indicate connection to the mains.

B IEC60417
No. 5008

"OFF" (power)
To indicate disconnection from the
mains.

C IEC60417
No. 5009

Stand-by
To identify the switch or switch
position by means of which part of the
equipment is switched on in order to
bring it into the stand-by condition.

D ISO7000
No. 0434B,
IEC3864-B3.1

Caution
To identify general caution when using
the product.

E IEC60417
No. 5041

Caution, hot surface
To indicate that the marked item can
be hot and should not be touched
without taking care.

F IEC60417
No. 6042
ISO3864-B3.6

Caution, risk of electric shock
To identify equipment that has risk of
electric shock.

G IEC60417
No. 5957

For indoor use only
To identify electrical equipment
designed primarily for indoor use.

No. Symbol mark Approved
standards

Description

H IEC60417
No. 5926

Polarity of d.c. power connector
To identify the positive and negative
connections (the polarity) on a piece
of equipment to which a d.c. power
supply may be connected.

I — The same as No. 8.

J IEC60417
No. 5001B

Battery, general
On battery powered equipment. To
identify a device for instance a cover
for the battery compartment, or the
connector terminals.

K IEC60417
No. 5002

Positioning of cell
To identify the battery holder itself and
to identify the positioning of the cell(s)
inside the battery holder.

L — The same as No. 11.

M IEC60417
No. 5019

Protective earth
To identify any terminal which is
intended for connection to an external
conductor for protection against
electric shock in case of a fault, or the
terminal of a protective earth electrode.

N IEC60417
No. 5017

Earth
To identify an earth (ground) terminal
in cases where neither the symbol No.
13 is explicitly required.
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No. Symbol mark Approved
standards

Description

O IEC60417
No. 5032

Alternating current
To indicate on the rating plate that the
equipment is suitable for alternating
current only; to identify relevant
terminals.

P IEC60417
No. 5031

Direct current
To indicate on the rating plate that the
equipment is suitable for direct current
only; to identify relevant terminals.

Q IEC60417
No. 5172

Class II equipment
To identify equipment meeting the
safety requirements specified for Class
II equipment according to IEC 61140.

R ISO 3864 General prohibition
To identify actions or operations that
are prohibited.

S ISO 3864 Contact prohibition
To indicate injury that could occur
due to touching a specific part of the
equipment.

T — Never look into the optical lens while
the projector is on.

U — To indicate that the marked item don’t
place anything on projector.

V ISO3864
IEC60825-1

Caution, laser radiation
To indicate the equipment has a laser
radiation part.

No. Symbol mark Approved
standards

Description

W ISO 3864 Disassembly prohibition
To indicate a risk of injury, such as
electric shock, if the equipment is
disassembled.

X IEC60417
No. 5266

Standby, partial standby
To indicate that part of the equipment
is in the ready status.

Y ISO3864
IEC60417
No. 5057

Caution, movable parts
To indicate that you must keep away
from movable parts according to
protection standards.

Z IEC60417
No. 6056

Caution （Moving Fan Blades)
As a safety precaution, stay away from
the moving fan blades.

a IEC60417
No. 6043

Caution (Sharp Corners)
To indicate sharp corners that should
not be touched.

b — To indicate that looking into the lens
while projecting is prohibited.

c ISO7010
No. W027
ISO 3864

Warning, Optical radiation (such as
UV, visible radiation, IR)
Taking care to avoid injury to eyes and
skin when in the vicinity of optical
radiation.

d IEC60417
No. 5109

Not to be used in residential areas.
To identify electrical equipment which
is not suitable for a residential area.
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This product is a laser projector that projects images onto surfaces such as walls
and screens.
This projector is a Class 1 consumer laser product that complies with the
following standards:
• IEC60825-1:2014
• EN60825-1:2014+A11:2021
Follow these safety instructions when using the projector.

Warning
• Do not open the projector's case. The projector contains a high-powered laser.
• Possibly hazardous optical radiation emitted from this product. Do not look at

operating light source. Eye injury may result.
• As with any bright source, do not stare into the beam, RG2 IEC/EN 62471-5:2015.

Caution
Do not disassemble the projector when disposing of it. Dispose according to your
local or national laws and regulations.

The projector uses a laser as the light source. The laser has the following
characteristics.
• Depending on the surroundings, the brightness of the light source may

decline. The brightness declines a lot when the temperature gets too
high.

• The brightness of the light source declines the longer it is used. You can
change the relationship between usage time and decline in brightness
settings.

g Related Links
• "Laser Warning Labels" p.140

Laser Warning Labels

Laser warning labels are attached on the projector.

Inside
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Top

• Never look into the projector lens when the laser is on. This can damage your
eyes and is especially dangerous for children and pets.

• When turning on the projector at a distance using the remote control, make
sure there is no one looking into the lens.

• Do not allow small children to operate the projector. Children must be
accompanied by an adult.

• Do not look into the lens during projection. Also, do not look into the lens
using optical devices, such as a magnifying glass or telescope. This could
cause visual impairment.

Bottom
The label attached on the projector varies depending on the countries and
regions.

• This projector is a Class 1 consumer laser product that complies with
EN50689:2021.

• This product is a laser projector that projects images onto surfaces such as
walls and screens.

For North/South America
The rating label contains the certification and identification information for the
projector.
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Warning
MOUNT ABOVE THE HEADS OF CHILDREN. The use of a ceiling mount is
recommended with this product to place it above the eyes of children.

Complies with FDA performance standards for laser products except for
conformance as a Risk Group 2 LIP as defined in IEC 62471-5: Ed. 1.0. For
more information see Laser Notice No. 57, dated May 8, 2019.
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This section briefly explains the difficult terms that are not explained in the text
of this guide. For details, refer to other commercially available publications.

Aspect Ratio The ratio between an image's length and its height.
Screens with a horizontal:vertical ratio of 16:9, such as HDTV
screens, are known as wide screens.
SDTV and general computer displays have an aspect ratio of 4:3.

Contrast The relative brightness of the light and dark areas of an image
can be increased or decreased to make text and graphics stand
out more clearly, or to make them appear softer. Adjusting this
particular property of an image is called contrast adjustment.

DHCP An abbreviation of Dynamic Host Configuration Protocol, this
protocol automatically assigns an IP address to equipment
connected to a network.

Full HD A screen size standard with a resolution of 1,920 (horizontal) ×
1,080 (vertical) dots.

Gateway Address This is a server (router) for communicating across a network
(subnet) divided according to subnet mask.

HDCP HDCP is an abbreviation for High-bandwidth Digital Content
Protection.
It is used to prevent illegal copying and protect copyrights by
encrypting digital signals sent over DVI and HDMI ports.
Because the HDMI port on this projector supports HDCP, it can
project digital images protected by HDCP technology.
However, the projector may not be able to project images
protected with updated or revised versions of HDCP encryption.

HDMI™ An abbreviation for High Definition Multimedia Interface.
HDMI™ is a standard aimed at digital consumer electronics
and computers. This is the standard by which HD images and
multichannel audio signals are digitally transmitted.
By not compressing the digital signal, the image can be
transferred at the highest quality possible. It also provides an
encryption function for the digital signal.

HDTV An abbreviation for High-Definition Television that refers to
high-definition systems which satisfy the following conditions:
• Vertical resolution of 720p or 1080i or greater (p =

Progressive, I = Interlace)
• Screen aspect ratio of 16:9

Interlace Transmits information needed to create one screen by sending
every other line, starting from the top of the image and working
down to the bottom.
Images are more likely to flicker because one frame is displayed
every other line.

IP Address A number to identify a computer connected to a network.

Progressive Projects information to create one screen at a time, displaying
the image for one frame.
Even though the number of scan lines is the same, the amount
of flicker in images decreases because the volume of information
has doubled compared with an interlace system.

Refresh Rate The light-emitting element of a display maintains the same
luminosity and color for an extremely short time.
Because of this, the image must be scanned many times per
second to refresh the light-emitting element.
The number of refresh operations per second is called the
Refresh rate and is expressed in hertz (Hz).

SDTV An abbreviation for Standard Definition Television that refers to
standard television systems which do not satisfy the conditions
for HDTV High-Definition Television.

sRGB An international standard for color intervals that was formulated
so that colors that are reproduced by video equipment can be
handled easily by computer operating systems (OS) and the
Internet. If the connected source has an sRGB mode, set both
the projector and the connected signal source to sRGB.

Subnet Mask This is a numerical value that defines the number of bits used for
the network address on a divided network (subnet) from the IP
address.
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Check these sections for important notices about your projector.

g Related Links
• "FCC Compliance Statement" p.144
• "Indication of the manufacturer and the importer in accordance with

requirements of EU directive" p.145
• "Restriction of Use" p.145
• "Operating System References" p.145
• "Trademarks" p.146
• "Copyright Notice" p.146
• "Copyright Attribution" p.146

FCC Compliance Statement

Supplier's DECLARATION of CONFORMITY
According to 47CFR, Part 2 and 15
Class B Personal Computers and Peripherals; and/or
CPU Boards and Power Supplies used with Class B Personal Computers

We: Epson America, Inc.
Located at: 3131 Katella Avenue, Los Alamitos, CA
Tel: 562-981-3840
Declare under sole responsibility that the product identified herein, complies
with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each
product marketed, is identical to the representative unit tested and found to
be compliant with the standards. Records maintained continue to reflect the
equipment being produced can be expected to be within the variation accepted,
due to quantity production and testing on a statistical basis as required by
47CFR 2.906. Operation is subject to the following two conditions: (1) this
device may not cause harmful interference, and (2) this device must accept any
interface received, including interference that may cause undesired operation.
Trade Name: EPSON
Type of Product: LCD Projector

Model: HC13A
Other Destination: HC13B
Options:

Product name Model

Remote controller 2214345 xx (x=0-9)

FCC Compliance Statement For United States Users
This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference,
and (2) this device must accept any interference received, including interference
that may cause undesired operation.
This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this
equipment does cause interference to radio and television reception, which can
be determined by turning the equipment off and on, the user is encouraged to
try to correct the interference by one or more of the following measures.
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to

which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment
will invalidate the FCC Certification or Declaration of this device and may
cause interference levels which exceed the limits established by the FCC for
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this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than
one interface connector, do not leave cables connected to unused interfaces.
Changes or modifications not expressly approved by the manufacturer could
void the user's authority to operate the equipment.

For Canadian Users

Indication of the manufacturer and the importer in
accordance with requirements of EU directive

Manufacturer: SEIKO EPSON CORPORATION
Address: 3-5, Owa 3-chome, Suwa-shi, Nagano-ken 392-8502 Japan
http://www.epson.com/

Importer: EPSON EUROPE B.V.
EU Address: Atlas Arena, Asia Building, Hoogoorddreef 5,1101 BA Amsterdam
Zuidoost The Netherlands
UK Address: Floor 3&4, The Clarendon Works, 37-39 Clarendon Road, Watford
WD17 1JA, U.K.
http://www.epson.eu/

Suplier in Middle East, Turkey, Africa, and Central & West Asia: Epson Middle East
FZCO
Address: 6WA-401 6W bldg., Dubai Airport Freezone, Dubai, United Arab Emirates
www.epson.com/eme

Restriction of Use

When this product is used for applications requiring high reliability/safety
such as transportation devices related to aviation, rail, marine, automotive etc.;
disaster prevention devices; various safety devices etc; or functional/precision
devices etc, you should use this product only after giving consideration to
including fail-safes and redundancies into your design to maintain safety
and total system reliability. Because this product was not intended for use
in applications requiring extremely high reliability/safety such as aerospace
equipment, main communication equipment, nuclear power control equipment,
or medical equipment related to direct medical care etc, please make your own
judgment on this product’s suitability after a full evaluation.

Operating System References

• Microsoft ® Windows® 8.1 operating system
• Microsoft ® Windows® 10 operating system
• Microsoft ® Windows® 11 operating system
In this guide, the operating systems above are referred to as "Windows 8.1",
"Windows 10", and "Windows 11". Furthermore, the collective term "Windows"
is used to refer to them all.
• macOS 10.13.x
• macOS 10.14.x
• macOS 10.15.x
• macOS 11.0.x
• macOS 12.0.x
• macOS 13.0.x
In this guide, the collective term "Mac" is used to refer to all of the operating
systems above.
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Trademarks

Mac, OS X, and macOS are trademarks of Apple Inc.
Microsoft, Windows, and Windows Server are trademarks or registered
trademarks of Microsoft Corporation in the United States and/or other
countries.
The terms HDMI, HDMI High-Definition Multimedia Interface, HDMI Trade
dress and the HDMI Logos are trademarks or registered trademarks of HDMI
Licensing Administrator, inc. 
PJLink trademark is a trademark applied for registration or is already registered
in Japan, the United States of America and other countries and areas.

Intel® is a registered trademark of Intel Corporation in the U.S. and/or other
countries.

Android TV™ is a trademark of Google LLC.
Other product names used herein are also for identification purposes only and
may be trademarks of their respective owners. Epson disclaims any and all
rights in those marks.

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in
a retrieval system, or transmitted in any form or by any means, electronic,
mechanical, photocopying, recording, or otherwise, without the prior written
permission of Seiko Epson Corporation. No patent liability is assumed with
respect to the use of the information contained herein. Neither is any liability
assumed for damages resulting from the use of the information contained
herein.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser
of this product or third parties for damages, losses, costs, or expenses incurred
by the purchaser or third parties as a result of: accident, misuse, or abuse of this
product or unauthorized modifications, repairs, or alterations to this product,

or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's
operating and maintenance instructions.
Seiko Epson Corporation shall not be liable against any damages or problems
arising from the use of any options or any consumable products other than
those designated as Original Epson Products or Epson Approved Products by
Seiko Epson Corporation.
The contents of this guide may be changed or updated without further notice.

Copyright Attribution

This information is subject to change without notice.
© 2025 Seiko Epson Corporation
2025.05 414638500EN

Notices 146



© 2022-2025 Seiko Epson Corporation.
Printed in XXXXXX


	Notations Used in This Guide
	Using the Manual to Search for Information
	Searching by Keyword
	Jumping Directly from Bookmarks
	Printing Only the Pages You Need

	Getting the Latest Version of the Documents

	Introduction to Your Projector
	Projector Parts and Functions
	Projector Parts - Front/Top
	Projector Parts - Rear
	Projector Parts - Base
	Projector Parts - Interface Ports
	Projector Parts - Control Panel
	Projector Parts - Remote Control


	Setting Up the Projector
	Projector Placement
	Notes on Transporting
	Projector Setup and Installation Options
	Projection Distance

	Installing the Safety Wire
	When Using the Ceiling Mount ELPMB22
	When Using the Ceiling Mount ELPMB30

	Projector Connections
	Connecting to an HDMI Video Source
	Connecting to a Computer for HDMI Video
	Connecting to a Streaming Media Player
	Connecting to External Devices
	Connecting to an eARC/ARC Compatible AV System or External Speakers
	Connecting to a Trigger Out Port


	Wired Network Connection
	Connecting to a Wired Network
	Selecting Wired Network Settings

	Installing Batteries in the Remote Control
	Remote Control Operation


	Using Basic Projector Features
	Turning On the Projector
	Turning Off the Projector
	Displaying a Test Pattern
	Projection Modes
	Changing the Projection Mode Using the Menus

	Adjusting the Image Position Using Lens Shift
	Adjusting the Projector's Tilt
	Image Shape
	Correcting Image Shape with H/V Keystone
	Correcting the Image Shape with Quick Corner
	Correcting Image Shape with Point Correction

	Resizing the Image with the Zoom Feature
	Focusing the Image with the Lens Button
	Selecting an Image Source
	Image Aspect Ratio
	Changing the Image Aspect Ratio
	Available Image Aspect Ratios

	Color Mode
	Changing the Color Mode
	Available Color Modes

	Adjusting the Image Quality
	Adjusting the Sharpness
	Setting Frame Interpolation
	Adjusting the Light Source Brightness
	Turning On Automatic Luminance Adjustment
	Adjusting the Image Resolution

	Adjusting the Image Color
	Adjusting the Color Temperature
	Adjusting the RGB Offset and Gain
	Adjusting the Gamma
	Adjusting the Hue, Saturation, and Brightness


	Adjusting Projector Features
	HDMI Link Features
	Operating the Connected Devices Using the HDMI Link Features

	Shutting Off the Image Temporarily
	Saving Settings to Memory and Using Saved Settings
	Using Advanced Image Adjustment Features
	Adjusting the Color Tone (Color Uniformity)

	Projector Security Features
	Locking the Projector's Lens Settings and Buttons
	Unlocking the Projector's Buttons

	Installing a Security Cable


	Monitoring and Controlling the Projector
	Controlling a Networked Projector Using a Web Browser
	Web Control Options

	Using ESC/VP21 Commands
	ESC/VP21 Command List
	Cable Layouts

	PJLink Support

	Adjusting the Menu Settings
	Using the Projector's Menus
	Using the Displayed Keyboard
	Available Text Using the Displayed Keyboard

	Image Quality Settings - Image Menu
	Input Signal Settings - Signal I/O Menu
	Projector Installation Settings - Installation Menu
	Projector Display Settings - Display Menu
	Projector Feature Settings - Operation Menu
	Projector Administration Settings - Management Menu
	Projector Network Settings - Network Menu
	Network Menu - Network Settings Menu
	Network Menu - Wired LAN Menu
	Network Menu - Projector Control Menu


	Image Quality Memory Settings - Memory Menu
	Projector Initial Settings and Reset Options - Initial/All Settings Menu
	Copying Menu Settings Between Projectors (Batch Setup)
	Transferring Settings From a USB Flash Drive
	Transferring Settings From a Computer
	Batch Setup Error Notification



	Maintaining the Projector
	Projector Maintenance
	Cleaning the Lens
	Cleaning the Projector Case
	Air Filter and Vent Maintenance
	Cleaning the Air Filters and Intake Vents
	Replacing the Air Filter

	Adjusting the Color Convergence (Panel Alignment)
	Updating the Firmware
	Updating Firmware Using a USB Storage Device
	Updating Firmware Using a Computer and USB Cable


	Solving Problems
	Projection Problems
	Projector Indicator Status
	Viewing the Status Display
	Projector Status Display Messages

	Solving Projector Power-On or Power-Off Problems
	Solving Projector Power Problems
	Solving Projector Shutdown Problems

	Solving Image Problems
	Solving Missing Image Problems
	Adjusting an Image that is not Rectangular
	Adjusting a Fuzzy or Blurry Image
	Fixing Partial Image Problems
	Adjusting an Image that Contains Noise or Static
	Adjusting an Image with Incorrect Brightness or Colors
	Adjusting an Upside-down Image
	Synchronizing Image and Sound

	Solving Sound Problems
	Solving Remote Control Operation Problems
	Solving HDMI Link Problems
	Solving Network Problems
	Solutions When You Cannot Access the Projector Through the Web


	Appendix
	Optional Accessories and Replacement Parts
	Mounts
	External Devices
	Replacement Parts

	Screen Size and Projection Distance
	Supported Monitor Display Resolutions
	Projector Specifications
	Connector Specifications

	External Dimensions
	List of Safety Symbols and Instructions
	Laser Safety Information
	Laser Warning Labels

	Glossary
	Notices
	FCC Compliance Statement
	Indication of the manufacturer and the importer in accordance with requirements of EU directive‏
	Restriction of Use
	Operating System References
	Trademarks
	Copyright Notice
	Copyright Attribution



